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Unit 01 – Fundamentals of ICT 
 
1.1 Introduction to ICT 
 
 
1.1.1 Use and importance of ICT in the economy 
 

Today, ICT has become an important part of day-to-day life.  Most human 

activities now take place with the aid of ICT solutions. The reason why is that, 

ICT gives more effective and speedy solutions to real life problems. In fact, a 

characteristic feature of this era is that people lead complex lifestyles with 

grater requirements that they seek rapid suitable solutions. ICT satisfies these 

requirements in a comprehensive manner and hence we name our current 

age of the earth, “ the ICT age”. 

 

 A few instances where usage of ICT occurs in our society are: 

 

 Banking systems 

[  ATM, Transactions, Tele banking, Credit card payments ] 

 Telecommunication systems 

[ Land & mobile phone operations, Fax, Internet, Telegrams.] 

 Transportation systems  

[ Air traffic controlling, Ticketing, Cargo operations, ] 

 Media institute 

[ Program manipulations, Transmission controlling, visual creations]  

 Medicine 

[ Chemical analysis, CT,MRI,US Scanning, ECG, EEG, Surgeries ]  

 Education 

[ CAL, CAD, Presentations, Publications, Explorations, Data bases } 

 Security & Defense 

[Signal operations, Missile guidance, and nuclear plant operations] 

 Construction industry, Fishing industry, Weather forecasting, etc. 
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In future, perhaps, other remaining areas of human interaction will also be dealt 

with through ICT. 
 
Today ICT is also used as a tool or vehicle for the development of the Society. It is 
used to empower or enhance economic development processes. 
 
In a variety of areas, access to and use of information can contribute to the  
empowerment of people, reduce poverty and improve lives, notably by: 
 
Providing access to relevant information 
 

• ICT can help improve the economic and social situation of the poor 
by enabling people  

• to obtain relevant information on market prices, weather conditions, 
medical assistance, land and political rights as well as welfare or 
credit schemes  

• increase their competitiveness and market access  
• Train them via e-learning, thus making them responsible for their own 

development.  
 

Giving a voice  
 
As a consequence of their poverty, the poor often lack an effective voice in public 
life and policy. ICT helps: 
 

• to increase the voice and participation of the poor in the decision-
making processes  

• communities to express their cultural identity  
• People assert their own rights and interests and pressure decision-

makers to be more responsive to their needs.  
• to increase the efficiency, transparency and accountability of 

governments and institutions  
• to promote local cultures and cultural diversity through local content  
 

Facilitating communication and network building 
 
By facilitating a new level of “many-to-many” information, ICT offer an interactive 
and decentralized platform that enables people to 
 

• share knowledge and build networks  
• promote their interest and rights more efficiently  
• influence more effectively, rapidly and collectively political, decisions 

that affect their lives  
• communicate more effectively, thus enhancing intercultural 
     understanding  
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Data Process 
(Calculate the average) 

Information 

1.1.2 Data and Information 
  

Data and information are two different concepts used in computer science.  
  

Data are raw facts that we input into the machine. 
Data are not restricted to numerical values. They may be a colour, picture or 
any object. 
 
 
      

                           Ravi is 55cm tall 
                             Nimal is 45cm tall     
                                    Amal is 85cm tall      
                         Sarath is 75cm tall 
                         Wimal is 65cm tall                           
    

 
Information is data that has been refined and organized by processing and 

 purposeful intelligence  
For example, according to the previous example, the following information 
can be obtained. 

 Amal is the tallest one 
 Nimal is the shortest one 
 Sarath is taller than Wimal 

 
 
 
 
 
 
 
 

For example, look at the following diagram; 
 
 
 
 
 

 
 
 
 
 
Now it is clear that raw data has no meaning and after processing it, we get 
meaningful information (average = 65 ).  As such, raw data can produce more 
information like Mode, Medium, etc... 

Names Hights (cm) 
Ravi 55 
Nimal 45 
Amal 85 
Sarath 75 
Wimal 65 

Name Marks for 
English 

Ravi 55 
Nimal 45 
Amal 85 
Sarath 75 
Wimal 65 

 
Data 

 
Meaningful  

 
Information 

Processing

Data Data

5
6575854555 ++++

=x

 
 

Average = 65 
= 

f
xx

∑ 

∑ 
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 1.1.3 ICT Tools 
 
ICT tools are components associated with ICT. They are either hardware or 
software items used to process information. They include;  

• Computers and Related Equipment 
• Communication Equipment 
• Software programs  

. 
Every year, a lots of ICT tools are manufactured by various companies in 
the world. 
For example, Input output devices, application software etc.  

 
 

 Bar code readers 
  Used in super markets & shops 
  to read bar codes which contain 
  information about that particular product.     

 
  
  
 

 Bar code printers 
 Used to print information about a particular 

   product in Barcode format     
  
 
 
 
 

 Credit card readers 
  Used to read credit cards 

 
 
 
 
 
 

 Telephones      
For communication and used to  
connect to the Internet. 
 
 
 
 
 
 

 Software Edit Photos/Pictures and creating graphic arts.  
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1.2 Introduction to computers 
 
1.2.1 Evolution of a computer to the present state  

 
 
The history of computer development is often referred to in reference to the 
different generations of computing devices. A major technological development 
that fundamentally changed the way computers operate, resulting in increasingly 
smaller, cheaper, more powerful and more efficient and reliable devices 
characterize each generation of the computer. Read about each generation and 
the developments that led to the current devices that we use today.  

i. A Brief History of Computers 
Ancient Times 
In the beginning, man used his fingers and toes to perform simple computations 
such as addition and subtraction. Later, man realized that by using some objects to 
represent digits, it might be possible to perform computations beyond the limited 
scope of one’s own fingers and toes. 
 
The first man-made computing device is the “Abacus”. In the Abacus, small beads 
are arranged on a series of vertical rods in a manner that by manipulating them, it 
is possible with some skill and practice, to make rapid calculations. Addition, 
subtraction, division and multiplication can be performed on a standard abacus. 
The abacus is still in use today by shopkeepers in East Asia and some parts of 
North America. 
 

 
Figure 1.2 – The Abacus 

 
Besides the abacus, early man also invented numbering systems to enable him to 
easily handle numbers greater than 10. One such numbering system is the decimal 
numbering system, which is traceable to early Hindu-Arabic influence. This decimal 
system, with specific digits representing numbers from 0 to 9, came into general 
use in Europe and has survived ever since. 
 
1600 – 1900 
In 1642, Blaise Pascal, a French mathematician, invented an adding machine. The 
machine has adopted partly the principles of the abacus but did away with the use 
of the hand to move the beads or counters. Instead, Pascal used wheels to move 
counters. 
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Figure 1.3 – Adding Machine, In 1642, Blaise Pascal  
 

The principle of Pascal’s machine, such as in the counters of tape recorders and 
odometers is still being used today. Pascal’s machine was one of the first 
mechanical calculating machines. 
 
In 1674, Gottfried Wilhelm Von Leibnitz made improvements on Pascal’s machine. 
With Leibnitz’s improvements, it was possible for the machine to divide and 
multiply as easily as it could add and subtract. 
 
When the age of industrialization spread throughout Europe, new machines  were 
invented to be used  in agricultural and production sites. An invention that made 
profound changes in the history of industrialization was the mechanical loom 
invented by a Frenchman named Joseph Jacquard. With the use of cards punched 
with holes, it was possible for the Jacquard loom to weave fabrics in a variety of 
patterns. 
 
The idea of using a punched card to store a predetermined pattern to be woven by 
the loom clicked in the mind of Charles Babbage, an English mathematician who 
lived in the nineteenth century. He foresaw a machine that could perform all 
mathematical calculations, store values in its memory and perform logical 
comparisons among values. He called it the Analytical Engine. Babbage’s 
analytical engine, however, was never built. The technology of that time was not 
adequate for building Babbage’s dream because electronics was not yet known or 
even thought of.   
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Figure 1.4 – Babbage’s Analytical Engine 
 
 
Herman Hollerith adopted the punched card concept of Jacquard to devise a 
system to process census data. Census data were translated into a series of holes 
in a punched card to represent the digits and the letters of the alphabet. It was then 
passed through a machine with a series of electrical contacts, which were either 
turned off or on depending on the existence or non-existence of holes in the 
punched cards. These different combinations of off/on situations were recorded by 
the machine and represented a way of tabulating the results of the Census. The 
Code developed by Hollerith is   called the Hollerith Code. 
 
Hollerith’s machine was highly successful. It reduced by two thirds the time it took 
to tabulate the result of the Census manually.   
 
1900 – 1945 
Howard Aiken of Harvard University thought that technology in 1937 was just right 
to implement Babbage’s concept. With the combined effort of his colleagues in 
Harvard and IBM, the Automatic Sequence Controlled Calculator was built in 1944 
and it was called MARK I. 
 
MARK I could perform division, multiplication, addition and subtraction in a 
specified sequence determined by the setting of the switches. MARK I used a 
typewriter connected to it or punched cards to output results. It contained more 
than three thousand electro-mechanical relays and weighed five tons. MARK I was 
used for 15 years. 
 
1946 – 1960 
The ENIAC (Electronic Numerical Integrator and Computer) was the first electronic 
digital computer. It was built in 1946 at the Moore School of Electrical Engineering 
of the University of Pennsylvania. The ENIAC had no moving parts. It was 
programmable and had the capability to store calculation steps. The ENIAC used 
vacuum tubes (about 18,000 in number).  
 
A computer using vacuum tube technology is referred to as a first-generation 
computer.   The ENIAC could perform an addition in 0.2 millisecond. This means 
that the machine was capable of performing about 5,000 computations per second. 
The principal drawback of ENIAC was its size and processing ability. It occupied 
1,500 square feet of floor space and could process only one program or problem at 
a time. 
 
In the 1950s, Remington Rand manufactured the UNIVAC I (Universal Automatic 
Calculator). It could calculate at the rate of 10,000 additions per second. In  1957, 
the International Business Machine Corporation (IBM) developed IBM 704 which 
could perform 100,000 calculations per second. 
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The Age of Transistors 
In the late 1950s, transistors were invented and quickly replaced the thousands of 
vacuum tubes used in electronic computers. Transistor-based computers could 
perform 200,000 to 250,000 calculations per second. The transistorized computer 
represents the second generation of the computer. 
 
It was not until the mid-1960s that the third generation of computers came into 
being. These were characterized by solid state technology and integrated circuitry 
coupled with extreme miniaturization. The fourth-generation of computers came 
into being after 1971. These computers were characterized by further 
miniaturization of circuit, increased multiprogramming and virtual storage memory. 
 
In the 1980s, the fifth-generation of computers were operating at speeds of 3 to 5 
million calculations per second (for small-scale computers) and 10 to 15 million 
instructions per second (for large-scale computers). 
 
The Age of Microcomputers 
 
8080, 8086, 80286,  80386-(SX,DX Bluthonder), 80486, Pentium 
The age of microcomputers began in 1975 when a company called MITS 
introduced the ALTAIR 8800. It was a computer, which can be programmed by 
flicking switches on the front. It came as a kit and had to be soldered together. It 
had no software programs, but it was a personal computer available to the 
consumer for a few thousand dollars when most computer companies were 
charging tens of thousands of dollars for their computers. In 1977, both 
Commodore and Radio Shack announced that they were going to make personal 
computers.   Mass production of the APPLE began in 1979, and by the end of 
1981, it was the fastest selling of all the personal computers. 
 

GENERATIONS OF COMPUTERS 

  FIRST (early 
50's) 

SECOND 
(late 50's) THIRD (60's) FOURTH 

(70's +) 

Technology vacuum 
tubes Transistors Integrated 

circuits 
microchips 
(LSI, VLSI) 

Relative 
speed 1 100 100 1,000,000 

+++ 
Relative cost 1 0.1 0.01 0.001 --- 
RAM capacity 
(bytes) 1,000-8,000 4,000-64,000 32,000- 

4,000,000 
32,000,000++
+ 

External 
storage cards Tape magnetic 

disks mass storage 

Operating 
System 

Single user; 
jobs 
scheduled 
manually 

Single user; 
jobs 
scheduled 
automatically 

Multiple 
users; time- 
sharing 

Multiple 
users; 
distributed   
systems 
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First Generation - 1940-1956: Vacuum Tubes 

The first computers used vacuum tubes for circuitry and magnetic drums for 
memory, and were often enormous, taking up entire rooms. They were very 
expensive to operate and in addition to using a great deal of electricity, generated 
a lot of heat, which was often the cause of malfunctions. First generation 
computers relied on machine language to perform operations, and they could only 
solve one problem at a time. Input was based on punched cards and paper tape, 
and output was displayed on printouts.  

The UNIVAC and ENIAC computers are examples of first-generation computing 
devices. The UNIVAC was the first commercial computer delivered to a business 
client, the U.S. Census Bureau in 1951.  

 

 

 

Power PC G3/G4 

Power Pc

68040 
68030 
68020 
68010 
68000 
 

Model 
(Motorola) 

2001

YEAR

1990

1986

1982

 

2000

1997

1997

1800-2000 Pentium IV 

1200Pentium III 

350- 450 Pentium II 

166/200 Pentium  MMX 

66-7580486 
4080386 

2080286 
16 80186 
4-8 8086 

88088 

Speed ( MHz) 
(roughly) 

Model (Intel) 
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Atanasoff-Berry Computer 

1939,  
magnetic drum memory of the 

Atanasoff-Berry Computer 
1939, from Smithsonian NMAH

Whirlwind core memory  first computer bug 1945 

 

 
UNIVAC 1951, from 
Smithsonian NMAH 

UNIVAC I ca. 1955, from 
Smithsonian 

UNIVAC ad 1955/01/17 
from Time 

UNIVAC ad 1955/02/28 
from Time 

UNIVAC I of 1951 was the first business computer made in the U.S. "Many people 
saw a computer for the first time on television when UNIVAC I predicted the outcome 

of the 1952 presidential elections." 
 

  
Bendix G-15 of 1956, inexpensive at $60,000, for science and industry but could also 
be used by a single user; several hundred were built - used magnetic tape drive and 

key punch terminal 
 

 
IBM 650 that "became the most popular medium-sized computer in America in the 

1950's" - rental cost was $5000 per month - 1500 were installed - able to read 
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punched cards or magnetic tape - used a rotating magnetic drum main memory unit 
that could store 4000 words, from Smithsonian NMAH 

Second Generation - 1956-1963: Transistors 

Transistors replaced vacuum tubes and ushered in the second generation of 
computers. The transistor was invented in 1947 but did not see widespread use in 
computers until the late 50s. The transistor was far superior to the vacuum tube, 
allowing computers to become smaller, faster, cheaper, more energy-efficient and 
more reliable than their first-generation predecessors. Though the transistor still 
generated a great deal of heat that subjected the computer to damage, it was a 
vast improvement over the vacuum tube. Second-generation computers still relied 
on punched cards for input and printouts for output.  

Second-generation computers moved from cryptic binary machine language to 
symbolic, or assembly, languages, which allowed programmers to specify 
instructions in words. High-level programming languages were also being 
developed at this time, such as early versions of COBOL and FORTRAN. These 
were also the first computers that stored their instructions in their memory, which 
moved from a magnetic drum to magnetic core technology.  

The first computers of this generation were developed for the atomic energy 
industry.  

 
transistor, from Smithsonian 

NMAH 
"First transistor (model), 

December 1947. Constructed 
by John Bardeen, Walter 

Brattain and William Shockley 
at Bell Laboratories," from 

Smithsonian NMAH 

Regency transistor radio 1954 
(TL), Zenith transistor hearing 
aid 1952, from Smithsonian 

NMAH 

Regency transistor radio 1954, 
from Smithsonian NMAH 

 
Philco and Emerson transistor 

radios, from Smithsonian 
NMAH transistor radios, from 

Smithsonian NMAH 

 
transistor radios, from 
Smithsonian NMAH 
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Maico hearing aid before and 
after transistors, from Fortune 

1953/03 

 
Morton, Shockley, White who 

developed transistor, from 
Fortune 1953/03 

 
RCA transistor ad, from 

Fortune 1953/03 

 

Third Generation - 1964-1971: Integrated Circuits 
The development of the integrated circuit was the hallmark of the third generation 
of computers. Transistors were miniaturized and placed on silicon chips, called 
semiconductors, which drastically increased the speed and efficiency of 
computers.  

Instead of punched cards and printouts, users interacted with third generation 
computers through keyboards and monitors and interfaced with an operating 
system, which allowed the device to run many different applications at one time 
with a central program that monitored the memory. Computers for the first time 
became accessible to a mass audience because they were smaller and cheaper 
than their predecessors.  

 
DEC PDP-1 of 1960, from CHM 

DEC PDP8/E minicomputer 1973 
from SDCM - cu 

 
Anderson Jacobson ADC 260 
acoustic coupler 1963, from 

SDCM 

 
early transistor calculators - 

Casio "Mini" used chips from TI 
(left); TI SR-10 calculator 

showing circuit in transparent 
case, used a single chip 1972, 

from Smithsonian NMAH 

early transistor calculators - 
Casio "Mini" used chips from TI 

(left); TI SR-10 calculator 
showing circuit in transparent 
case, used a single chip 1972, 

from Smithsonian NMAH 

IC, from Smithsonian NMAH 

IC, from Smithsonian NMAH 

 

Fourth Generation - 1971-Present: Microprocessors 
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The microprocessor brought the fourth generation of computers, as thousands of 
integrated circuits were built onto a single silicon chip. What in the first generation 
filled an entire room could now fit in the palm of the hand. The Intel 4004 chip, 
developed in 1971, located all the components of the computer - from the central 
processing unit and memory to input/output controls - on a single chip.  

In 1981 IBM introduced its first computer for the home user, and in 1984 Apple 
introduced the Macintosh. Microprocessors also moved out of the realm of desktop 
computers and into many areas of life as more and more everyday products began 
to use microprocessors.  

As these small computers became more powerful, they could be linked together to 
form networks, which eventually led to the development of the Internet. Fourth 
generation computers also saw the development of GUIs, the mouse and handheld 
devices.  

Fifth Generation - Present and Beyond: Artificial Intelligence 

Fifth generation computing devices, based on artificial intelligence, are still in 
development, though there are some applications, such as voice recognition, that 
are being used today. The use of parallel processing and superconductors is 
helping to make artificial intelligence a reality. Quantum computation and molecular 
and nanotechnology will radically change the face of computers in years to come. 
The goal of fifth-generation computing is to develop devices that respond to natural 
language input and are capable of learning and self-organization.  

 

 
Microsoft Reader 

Michael Crichton displays a 
handheld computer with his 

latest bestselling novel 
"Timeline" in Microsoft Reader 

form on the screen (AP 5/23/00)

digital insertion ad digital insertion ad 
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Jeff Bezos of amazon.com 

wearable computers 

Apple G4 
Linux 

 
 

1.2.2 Components and Peripherals of a computer system 
(See 1.2.4) 
 

1.2.3 Classification of computers 
Different types of computers. (According to size) 
A number of different dimensions can be used to classify computers into different 
types. Traditionally, the size and the capabilities of computers are used as the 
main criterion and the computers are classified into the following types. 

• PC – The personal computer (PC) is small in size and is designed for general 
use by a single person.   

 Desktop – A PC that is not designed for portability. A desktop computer is 
typically set up in a permanent location. 

 Laptops (Notebooks) – A portable computer that includes a battery to 
provide power for some specific period of time.  

 Palmtop – More commonly known as Personal Digital Assistants (PDAs).  
Palmtops are small, lightweight and tightly integrated computers which 
usually do not have keyboards but rely on touch screen technology for user 
input. Palmtops are  equipped with a battery with reasonable life. 

 Workstation – A desktop computer with a powerful processor, additional 
memory and enhanced capabilities for performing a special group of tasks, 
such as 3D graphics. 

• Server – A computer that has been optimized to provide services to other 
computers over a network. Servers usually have powerful processors, lots of 
memory and large hard drives.  

• Mainframe – Mainframes are huge computers, which could fill an entire room or 
even a whole floor.  Over the years, the size of computers has diminished while 
the power has increased; the term mainframe has fallen out of use. You will still 
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hear the term used, particularly in large companies to describe the huge 
machines processing millions of transactions every day.  

• Supercomputer – This type of computer is usually very expensive. Although 
some supercomputers are single computer systems, most comprised multiple 
high performance computers working parallel as a single system. The best-
known supercomputers are built by Cray Supercomputers. 

Different types of computers. (According to technology) 
DIGITAL COMPUTER 
A computer that stores data in terms of digits (numbers) and proceeds in discrete 
steps from one state to the next. The states of a digital computer typically involve 
binary digits, which may take the form of the presence, or absence of magnetic 
markers in a storage medium (see memory), on-off switches or relays. In digital 
computers, even letters, words and whole texts are represented digitally. Unlike 
analog computers, digital computers can only approximate a continuum by 
assigning large numbers of digits to a state description and by proceeding in 
arbitrarily small steps. 
 
Analog computers 
Analog computers are based on principles completely different from digital 
computers. Problem variables are represented by electrical voltages which can 
vary continuously within a certain range, usually –10 to +10 volts for a transistor-
based machine. Electronic circuit modules allow the variables to be added, 
integrated (with respect to time) and multiplied by a constant. This makes it is 
possible to solve a system of ordinary linear differential equations by properly 
combining a number of adders, integrators, amplifiers and potentiometers using 
flexible chords and a patch panel (see the examples). The top illustration shows a 
small part of the patch panel of the Museum’s EAI Model 680 computer. 
 
Hybrid computer 
 
Hybrid computers are made by combining features of analog computers and digital 
computers. 
 

1.2.4 Computer Architecture 
 
Components of a Computer System 
 
By considering the functions performed by the various components, a computer 
can be represented as a collection of logical components as in Figure 1.3. The 
main hardware components of a modern computer system are the central 
processing unit (CPU), the main memory, the secondary storage and the input-
output devices. 
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Figure 1.9 – System Unit 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 1.8 – Block Diagram for Computer System 
 

 
System Unit 
The system unit, or the cabinet houses most of the 
essential components of  the computer system such 
as the power supply, the motherboard, the CPU chip, 
specialized chips, the system clock, RAM, ROM, 
expansion boards and bus lines. 
 
 
 
Central Processing Unit (CPU) 
The central processing unit performs the majority of calculations and controls the 
operation of a computer. CPUs are rated by the speed at which they can execute 
instructions.  The speed of a CPU is measured in Megahertz (MHz), and is also 
known as the clock speed. The higher the value of the speed the faster the 
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Figure 1.10 – CPU 

computer can run programs. The capacity of a CPU is expressed in terms of word 
size. A word is the maximum number of bits that the CPU can manipulate or store 
at one time. 

 
 
 
 
 

 
Different manufacturers are making CPUs today. Some of these popular CPUs 
available today are the Intel, AMD, Cyrix and Motorola. The CPU consists of two 
parts: the control unit (CU) and the arithmetic/logic unit (ALU).  
 
Control Unit (CU) 
The control unit controls and directs the operation of the entire computer system. 
Although it does not perform any actual processing on the data, the control unit 
acts as a central nervous system for the other components of the computer. It 
obtains instructions from the program stored in main memory, interprets the 
instructions, and issues signals, which cause other units in the system to execute 
them. 
 
Arithmetic-Logic Unit (ALU) 
The Arithmetic-Logic unit performs arithmetic operations such as addition, 
subtraction, multiplication and division on data. It also performs logical operations, 
which involve comparison of data. 
In microcomputers, the entire CPU is typically fabricated on a single chip.    
 
CPU Properties 
Property Meaning Units 
Speed The number of operations which can be performed per 

second 
MHz 

Word Size The largest number of bits which can be handled in one 
operation 

Bit 

Data Path The largest number of bits which can be transported into 
the chip in one operation 

Bit 

Maximum 
Memory 

Amount of memory that CPU can address MB 

 
 
 
Mother Board  
 
The mother board is the main circuit board inside the computer. It can be 
considered as the main communication centre through which all the components of 
the computer transmit data back and forth.  All the main parts including the CPU of 
the computer are typically plugged into the motherboard. The motherboard also 

Table 1.2: CPU Properties 
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provides sockets, called expansion slots, to plug in special electronic circuit 
boards to enhance the functionality of the computer.  These extra circuit boards 
are called expansion cards, by using which you can customize a computer to suit 
your needs. One other major function of the motherboard is to supply the 
necessary power to all its expansion cards. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 1.11 – The mother board  

 
System Clock 
Computers run to the beat of a clock. A clock in the computer that ticks one million 
times per second is called a one megahertz (1MHz) clock. Generally a faster clock 
means faster execution of programs, hence better performance. However the 
actual performance of a computer depends on many other factors. 
Power Supply  
The regulated power supply inside the computer transforms mains electricity into 
DC current used in the computer. It has an internal fan to cool the unit. 
 
Peripheral Devices 
Peripheral devices are the components of the computer which are situated outside 
the main casing of the computer. Peripheral devices are typically connected to the 
computer by using ports. 
 
 
 

ii. Different Types of Ports 
A typical computer may provide a number of different types of ports to connect 
external devices to it. Some of these different port types and their typical usages 
are explained in the following sections. 
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Figure 1.12 –System Unit, Ports Layouts 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Serial Port 
A serial port is used to connect external modems or an older computer mouse to 
the computer. There are two serial port versions :  9-pin version , or 25-pin version.  
Serial port is a male port and the typical data transfer rate over a serial port is 115 
kilobits per second. 
 
 
 
 
 
 
 
 
 
Video Card Port    
This connector is used to connect a computer display monitor to a computer's 
video card. The port is a female port and has 15 holes.   
 
 
 
 
 
 
 
Parallel Port 
A Parallel port has 25 holes and is commonly known as the printer port. They are 
used to connect external devices such as scanners and printers.  
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PS/2 Port 
A PS/2 port, also referred to as a mouse port, is used to connect a mouse or 
keyboard with the computer. Most computers come with two PS/2 ports, one for 
the keyboard and the other for the mouse. 
  
 
 
 
 
 
 
 
 
 
USB Port 
A universal serial bus (USB) port is a fairly new port - introduced around 1997. This 
port can be used to connect all kinds of external devices, such as external hard 
drives, printers and mice, scanners. USB-compliant devices can draw power from 
a USB port.  USB 2.0 connectors were introduced in 2003 and are capable of 
transferring  data at 480 Mbps.   
 
 
 
 
 
 
 
 
Ethernet (Network) Port 
This port is used to connect the computer to a network or to Internet. Data travels 
through this port at speeds of either 10 Megabits or 100 Megabits depending on 
the speed of the network card in the computer. Little monitor lights on these 
devices flicker when the port is in use. 
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iii. Storage  
Generally, computers provide many different types of storage systems. The 
different types of storage systems in a computer can be arranged in a hierarchy 
according to speed and their costs as shown in Figure 1.12. In this figure, as we 
move down the hierarchy, the cost to store a bit generally decreases, whereas the 
access time generally increases. 
 

Figure 1.13 – Storage Systems Comparison 
 
The smallest unit of data that can be stored in a computer is a bit. A bit will have 
the value ‘0’ or ‘1’ .  A large collection of such ‘0’s or ‘1’s is what makes up data in 
a computer. 
 
Smallest Unit   - 1 bit 
8 bits    - 1 byte 
1024 bytes  - 1 kilobyte (KB) 
1024 kilobytes  - 1 megabyte (MB) 
1024 megabytes - 1 gigabyte (GB) 
1024 gigabytes  - 1 terabyte 

( In computer jargon, One Kilo = 102 =1024) 
The capacity of a particular storage device and the space taken up by a file are 
always measured using these units. 
 

Memory 
The programs and data must be in the main memory to be used by the CPU. The 
main memory is the only large storage area that the CPU can access directly. 
Memory of a computer is measured in Megabytes.  
  
The three basic types of memory used in a computer are Cache Memory, 
Random Access Memory (RAM) and Read  Only Memory (ROM) . 

Registers 

Cache 

Main Memory 

Disks 

Magnetic Tapes 

Cost 

Access 
Time 
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 ddadad

Figure 1.14 - Drive Physical and 

 
Cache Memory 
The CPU contains a small amount of internal memory to keep data temporally for 
its immediate computations. This memory is called Level 1 cache. If the data 
required by the CPU is not in Level 1 cache, the Level 2 cache is searched. The 
Level 2 cache is situated typically outside the processor chip. The advantage of 
cache memory over normal RAM is that the cache can be searched quicker than 
the normal RAM. 
 
 Random Access Memory (RAM)  

RAM or the main memory is 
the computer’s short-term 
memory that temporarily 
holds data and instructions, 
which will be needed shortly 
by the CPU. Data and 
instructions can be stored 
and retrieved from 

anywhere in the RAM, and the time taken for such 
operations is approximately the same irrespective 
of the locations they are stored in the RAM. RAM 
is volatile, which means that it loses its data when 
the computer is turned off. RAM is supplied in 
modules; small circuit boards which can be 
plugged into the motherboard in special sockets. 
 
Read Only Memory (ROM) 
A type of data storage device, which is 
manufactured with fixed contents. ROM is also 
known as firmware. ROM is non-volatile storage 
in contrast to RAM. It retains its contents even 
when the power is switched off. ROM stores critical programs such as the program 
that boots the computer.  In addition, ROM is used extensively in calculators and 
peripheral devices such as laser printers.  

Secondary Storage 
Secondary or auxiliary storage devices are used to store large volumes of 
information more permanently. They can be used as input and output devices. 
There are many types of secondary storage devices. 
 
Hard Disks 
A hard disk drive is a device housed inside the computer, on which data is stored 
for later retrieval. Most computers will have at least one hard disk. A hard disk 
consists of multiple disk "platters" (magnetic surfaces) on which data is 
electronically ‘written’. Data can be written or read from the hard disk. These 
surfaces on which data is written are usually sealed inside a drive (casing), to 
prevent contamination and moisture. Hard disks are considered the most reliable 
method of storage. Hard disk storage capacities range from a few hundred 
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megabytes to many gigabytes.  The speed of a hard drive is measured in terms of 
average access time, the speed at which the hard drive finds data. The average 
access time is measured in milliseconds (1/1000 of a second). 
 
While hard disk drives are usually installed inside the system unit of the computer, 
there also are portable hard drives that can be connected to the computer 
externally. Such hard drives are useful as they can be used to transfer large 
quantities of data between different computers. 
 
Floppy Disk  
A floppy disk or a diskette is a round flat removable 
piece of plastic plate coated with a Ferric Oxide layer, 
and encased in a protective plastic cover, called the 
disk jacket. The Ferric Oxide layer is capable of holding 
a magnetic field.  Data is stored on a floppy disk by 
means of a disk drive, which alters the magnetic orientation of the particles in the 
Ferric Oxide layer. Reading data from a diskette means that the data stored as a 
magnetic pattern on a diskette is converted to electronic signals and transmitted to 
the memory of the computer. Writing data on a diskette means electronic 
information is transformed into magnetic patterns and recorded magnetically on the 
diskette. 
 
Floppy disks are made to be removable and easy to carry. They are more sensitive 
and unreliable than hard disks. Floppy disks are also slower than hard disks and 
the storage capacity is typically 1.44 megabytes. 
 
 

Evolution of Diskettes 
Year 
Introduced 

Physical Size 
(in inches) 

R/W 
Capability

Maximum 
Capacity 

Number of 
sides used 

1970s 8 R 100 Kilobytes Single 
1973 8 R/W 250 Kilobytes Double 
1976 5.25 R/W 100 Kilobytes Single 

 5.25 R/W 1.2 Megabytes Double 
1980 3.5 R/W 1.44 

Megabytes 
Double 

Table 1.3 - Evolution of Diskettes 
 

Zip disks and Jaz disks 
These disks are very similar to floppy disks except that 
they can be used to store large amounts of data. Zip disk 
capacities range from 100 to 750 MB and Jaz disks come 
in 1  & 2 GB capacities. Both these disks are removable 
and portable and provide much better performance than 
floppy disks. 
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Magneto optical disk 
Magneto optical disk drives use a combination of a laser, to heat the surface of the 
disk, and a magnetic head, to record data. While these disks are high 
performance, they are expensive. Magneto optical disks have capacities ranging 
from 128 MB to several gigabytes. 
 
Magnetic Tape 
Magnetic tapes are similar to audiotapes and store data in a serial manner (i.e. 
data is stored one after the other on the tape). These tapes can store large 
amounts of data but are primarily used for backup purposes because the access 
speeds are slow. 
 
 
CD/ DVD 
A compact disc is a plastic disc where data is optically ‘written’ on its surface. The 
data written on the disc is read using a CD-ROM drive which uses lasers for this 
purpose. Usually once the data has been ‘written’ (or ‘burnt’) on 
to the CD, it is not possible to change it, hence Read Only 
Memory. The faster the CDROM drive can read a CD, the faster 
the computer will be able to get data from the CD. Digital 
Versatile Discs (DVD) use a similar concept to CDs except that 
they are able to use multiple surfaces on a single disc and so can 
be used to store larger amounts of data. A typical CD can store 650 to 700 MB of 
data while a DVD can store from 2GB to 8 GB of data. Some CDs are re-writeable. 
To ‘write’ on a CD, a drive called ‘CD Writer’ must be used.  
 
Formatting 
Hard disks and Diskettes must be formatted before saving data on them. 
Formatting can be considered as an initialization process that prepares the disk or 
diskette electronically so that it can store data or programs. 

Data Hierarchy 
Data in storage can be organized into a hierarchy of categories. 

• Character : a single letter, number or a special character. 
• Field : Typically, a sequence of characters. 
• Record : Collection of related fields 
• File : Collection of related records 
• Databases : Collection of interrelated files. 
 

Input Devices 
Input devices enable data to be fed into the computer in a form that the computer 
can use. Input devices are categorized into two types:  keyboard entry devices and 
direct entry devices. A device through which data can be entered to the computer 
by pressing keys is called a keyboard entry device whereas all the other types of 
input devices are called direct entry devices. 
Keyboard 
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Figure 1.15 – Mice 

The keyboard is the most commonly used input device and has been used since 
computers were first introduced. They are intelligent devices and contain their own 
chips. Each key is a switch, which closes when that particular key is pressed. The 
microprocessor scans the keyboard hundreds of times a second to see if a key has 
been pressed; if it has, a code that corresponds to that key is sent to the 
Processing Unit. The CPU then translates this code into the ASCII code (the code 
that computers use to represent characters on the computer keyboard), which is 
then used by the computer program. 
 
Mouse 
 A mouse is another popular input device that forms 
an essential part of a computer system. Its 
movements on the desktop are translated into digital 
information, which in turn is fed to the computer, 
causing the cursor to move on the screen. 
Underneath the mouse there is a ball which rotates 
when the mouse is moved by the user and sensors 
pick up this movement. A mouse usually has two or 
three buttons, and these are used to make selections 
on the screen.  The Mouse is classified as a pointing 
device. Joysticks, Touch Screens and Light Pens are 
a few other examples for pointing devices. 
 
A newer type of mouse is the optical mouse. An 
optical mouse uses a light-emitting diode (LED), an 
optical sensor, and a digital signal processing (DSP) 
in place of the traditional mouse ball and electro-
mechanical transducer. Movement is detected by 
sensing changes in reflected light, rather than by 
interpreting the motion of a rolling sphere. 
 
 
 
 
 
 
Microphone 
A microphone can be used to record sound into a computer. Microphones are also 
used for voice communication through a computer, for example, for making 
telephone calls through a computer. 
 
 
Camera 
Digital Cameras store the images digitally rather than on film. Digital still cameras 
can be connected to a computer and the pictures taken on them can be transferred 
while digital motion cameras or web cams can be used to create video and for 
video conferencing purposes. 
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Figure 1.17 – Scanner 

 
 
 
 
 
 
 
 
 
 
 
 
Scanner 
Scanners are input devices normally used to scan text or pictures. The scans are 
then stored in a computer’s memory where they can then be accessed and 
modified using a desktop publishing package, before being printed. Both black and 
white, and colour scanners are available.  
 
Optical character recognition (OCR) is where the text on 
a page is scanned and then converted and fed into a 
word processing package so that it can be modified 
according to the needs of the user. Scanners often come 
with OCR software. OCR software may not recognize 
certain characters, be they handwritten, typed fonts or 
symbols. 
 
Other Devices 
A variety of devices exist which allow people to input different kinds of information 
into a computer. Some such devices are: 
 

• Fingerprint reader -  Used to capture a fingerprint of a person into the 
computer 

• Magnetic Ink Character Recognition (MICR) - Used to recognize characters 
printed in special ink. e.g. on cheques 

• Environment Sensors - Movement, Temperature, Humidity,  etc., can be 
monitored through a computer using these devices. 

 

Output Devices 
Output devices translate information processed by the computer into a form that 
either humans or other machines can understand. There are a variety of output 
devices, which can be connected to a computer. Some of the common output 
devices are explained in the following sections. 
 
Monitor  
The most common form of output is the computer screen. It is more correctly called 
the ‘monitor’ and sometimes referred to as the visual display unit or VDU. 
  

Figure 1.16 – Digital Camera 
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Figure1.18- CRT/LCD 
Monitors

The quality of a computer monitor is based on the following properties: 
• Resolution: Resolution is the number of pixels, which the screen can 

display. A ‘pixel’ is the ‘picture element’ and refers to the smallest area of 
the screen that the computer can change.  

• The number of colours it can display (dependent on the computer as well) 
• Radiation output. 

 
 
 
 
 
Different types of display screens 
 

• CRT monitor – A cathode-ray tube and 
associated electronics connected to the video 
output of a computer. These have higher 
resolution than TVs. Larger monitors with high 
resolution are used for specialized application 
such as desktop publishing and CAD. 

 
• Liquid crystal display (LCD) – LCDs are screens 

made from two glass/plastic plates with liquid in 
between. LCDs are commonly used for calculators 
and laptop computers, as they are far flatter than 
is possible with cathode ray screens used in TVs 
and standard computer monitors. 

 
Main differences of LCDs as compared with CRT 
monitors are : 

• Take s very little space 
• Small energy consumption 
• Sharp pictures 
• No flicker or geometric distortion 
• Fairly expensive 
• Limited viewing angle 
• Slower response time  

 
Printers 
 
Many different types of printer are in use today. Two primary technologies used for 
printing are impact printing and non-impact printing. Impact Printers use a print 
head containing a number of metal pins which strike an inked ribbon placed 
between the print head and the paper. The non-impact printers are much quieter 
than impact printers as their printing heads do not strike the paper. 
 
Three most common printer types are: 

Dot matrix printers, Inkjet printers and Laser printers. 
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Figure 1.19 – Dot 
Matrix

 
- Dot matrix printers -  These printers work by firing a matrix of tiny pins  

(which are located in the print head), through a ribbon similar to that 
found on a typewriter. Such printers are 
cheap and have the lowest running cost 
compared to any other type of printer. As 
the head moves across the paper the 
correct pins are fired out to hit an inked 
ribbon and form the shape of the 
character required. The greater the 
number of pins, the higher the quality of 
the print. Dot matrix printers are impact 
printers and are used to print multipart 
stationery. So to print several copies of 
a document at the same time you will 
need to use a dot matrix printer. 

 
- Inkjet printers - Inkjet printers can 

produce high quality text and 
graphics. They are quieter than dot 
matrix printers. The technology 
involves ink flowing through the 
appropriate nozzles (usually in an 
array of 64) where it is then heated 
and a bubble is formed. This 
expands to release a tiny droplet of 
ink onto the paper. 

 
 

- Laser printers  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Laser printer and it’s functionality  
 

Figure 1.20 -Inkjet 
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These non-impact printers offer high-speed printing and an excellent quality of text 
and graphics. A laser beam is used to form an image on a rotating, charged metal 
drum. This then picks up toner from the toner cartridge and transfers it onto paper. 
Very soon afterwards heat and pressure are applied so the toner sticks to the 
paper. Since they are page printers they are very fast.  Colour laser printers are 
now available and are mainly used for desktop publishing. Although they are 
expensive, they are likely eventually to come into widespread use. 
 
Speakers / Headphones 
Speakers or headphones may be used to get sound output from a computer. There 
are different types of speakers ranging from simple speakers, which provide simple 
sound to speakers, which can provide theatre-like surround sound. 
 
 
 
 
 
 
 
 
 
 
 
 
Speakers and Headphones 
 
1.3 Software 
 
Software refers to instructions which are used by the computer to perform various 
tasks. The word programme is synonymous with software. Software is created with 
programming languages and related utilities. Software is generally classified into 
two types: system software and application software. 
 
 
 
 
 
 
 
 
 
 
 
 

1.3.1 

  Application Programs 

           Utilities 

     Operating System 

       Physical Devices 

Abstract view of the Components of a computer system 
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System Software 
System software is responsible for controlling, integrating and managing the 
individual hardware components of a computer system so that other software and 
the users of the system see it as a functional unit without having to be concerned 
with the low-level details of the computer hardware. 
 
System software can be further classified as: 

• Operating Systems 
• Utilities and Service Programs 

 
Operating Systems (OS) 
The Operating System manages the resources and the basic operations of the 
computer. Without an operating system the computer would not work.   The 
operating system (or a part of it) is loaded into the main memory when the 
computer is switched on and handles many tasks, which we are unaware of when 
we use the computer. A part of the operating system remains in main memory until 
the computer is turned off. 
 
There are several operating systems used with personal computers such as 
Windows 98, Windows XP, Linux and Mac OS.  Different operating systems are 
designed for different hardware platforms or for different functions. 
 
Operating systems may provide different types of user interfaces such as 
Command Line Interface and Graphical User Interface (GUI). In the command 
line interface, users communicate with the operating system by typing commands 
using the keyboard. One of the main disadvantages of the command line interface 
is that the user has to memorize the commands exactly.  
 
The graphical user interface was first developed for Apple Macintosh Computers. 
In the graphical user interface, a user invokes a command by means of graphical 
objects shown on the screen and the system translates the user actions to the 
operating system commands and executes them on behalf of the user. 
 
The general-purpose operating systems are typically supplied on CD-ROMs and 
must be installed before using the computer. Some computers such as hand held 
computers come with pre-installed operating systems on the computers’ ROM. 
Such operating systems provide only limited capabilities and are virtually 
impossible to be upgraded. 
 
Utilities and Service Programs 
 
Another category of software is utility software, which is a collection of useful 
programs that enhance the capabilities of the operating systems. These software 
programs are designed to perform various tasks. Some examples of utility software 
are Norton Utilities and Download Accelerator. 
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Device Drivers 
Virtually every hardware component located inside or connected externally to a 
computer requires associated software component to enable that hardware to 
communicate and function with the operating system, other applications and other 
hardware components of the computer. This software component is referred to as 
driver software of that hardware component. Until you install the proper software 
derive for a hardware component that hardware component remains logically 
isolated from the rest of the components of the computer. 

1.3.2 Application Software 
Application software is designed to perform useful general-purpose tasks. For 
example, an application program called Solitaire is a single program that lets you 
play a card game. Application software can be grouped as customized software or 
as application packages. Customized software is generally designed for a 
particular customer whereas application packages are “off the shelf” programs 
designed for the general public.  
 
Common types of application software are: 

• Word Processing 
• Spreadsheet 
• Database Management System 
• Presentation Software 
• Desktop Publishing and Graphic Design 
• Web Design and Development 

Booting the Computer 
The process of loading the operating system into the computer’s main memory 
from the hard disc, floppy disk or CD  is called booting. A programme known as 
the boot routine or bootstrap loader is in change of the booting process and this 
boot routine is stored permanently in the computer’s electronic circuitry, typical in 
ROM. Another series of programmes which start up prior to the booting process 
are the diagnostic routines. These programs test the main memory, the CPU and 
other parts of the system to make sure that they are running properly.  
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1.4 Networking of Computers 
 

Network 
A network is a collection of entities that exchange information or goods. A few 
examples of networks are railway system, nervous system of animals, telephone 
system.   

Computer Network 

A network consists of two or more computers that are linked in order to share 
resources (such as printers and CD-ROMs), exchange files, or allow electronic 
communication. The computers on a network may be linked through cables, 
telephone lines, radio waves, satellites, or infrared light beams. 

A communications network is a system of interconnected computers, and 
communication devices that can communicate with one another and share 
resources.  At the most elementary level, a computer network consists of two 
computers connected with each other by a cable to allow them to share data. A 
device connected to a network is called a node. A node may be a device such as a 
computer, a printer, workstation etc. 
 

1.4.1 Advantages of Networks 
Networks offer several advantages over stand alone systems. Some of these 
advantages are listed below: 

Speed. Sharing and transferring files within Networks is very rapid. Thus 
saving time, while maintaining the integrity of the file. 

Cost. Individually licensed copies of many popular software programs can 
be costly. Networkable versions are available at a considerable saving. 
Shared programs, on a network allows for easier upgrading of the program 
on one single file server, instead of upgrading individual workstations.   

Security. Sensitive files and programs on a network are password 
protected (established for specific directories to restrict access to authorized 
users) or designated as "copy inhibit," so that you do not have to worry 
about illegal copying of programs. 

Centralized Software Management.  Software can be loaded on one 
computer (the file server) eliminating that need to spend time and energy 
installing updates and tracking files on independent computers throughout 
the building.   

Resource Sharing. Resources such as, printers, fax machines and 
modems can be shared.   
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Electronic Mail. E-mail aids in personal and professional communication. 
Electronic mail on a LAN can enable staff to communicate within the 
building without  having tot to leave their desks.   

Flexible Access. Access their files from computers throughout the firm.   

Access to databases: Users can access numerous databases by making them 
available on the network. 
 
Workgroup Computing. Workgroup software (such as Microsoft BackOffice) allows 
many users to work on a document or project concurrently. 
 
 
Disadvantages of  Network    
 

 Server faults stop applications being available  
 Network faults can cause loss of data.  
 Network fault could lead to loss of resources  
 User work dependent upon network  
 System open to hackers  
 Decisions tend to become centralized  
 Could become inefficient  
 Could degrade in performance  
 Resources could be located too far from users  
 Network management can become difficult 

 
 
Common Network Elements  
The different types of components that you can find in a network are:   

• Servers: Computers that provide shared resources to the network users 
• Clients: Computers that access shared network resources provided by the 

users 
• Communication Media: The media through which data is being transmitted. 
• Network Operating system: Software that manages the activities of a 

network 
• Shared resources: Any service or resource made available for use by the 

members of the network. 
• Modem: used to connect a computer to another computer over phone lines. 
• Hub: A hub can be thought of as a junction box, permitting new computers 

to be connected to a network as easily as plugging a power cord into an 
electrical socket.  Hubs are commonly available in 4, 8, 16 port sizes, 
enabling anywhere from 4 to 16 network devices to be plugged into a 
network. There is no need to connect all the ports of a hub to network 
devices simultaneously. When no cables are plugged in, the signals bypass 
the unused ports. Some hubs have an additional interface port that 
connects to another hub, increasing the size of the network. 
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• Switch: An enhanced version of the hub. Typically a switch can distribute 
the communication load so all the computers connected to the switch can 
communicate effectively. 

1.4.2 TYPES OF NETWORKS 

Network Topologies  
Networks can be laid out in a number of different ways. The physical layout of a 
network is called its topology. The basic network topologies are star, ring, and bus. 
These basic topologies can be combined in a variety of ways to build complex 
hybrid network topologies. 
 
The decision on the best network structure required for an organization depends 
on its budgetary restrictions, types of resources to be connected and the 
productivity needs. 
 
Star Topology  
 
In a star network all computers and other communications devices are connected 
to a central point such as a hub, file server or a host computer. 
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Ring Topology 
 
 
 
 
In a ring network all communications 

devices are connected in a 
continuous ring. Messages are 
passed around the ring until they 

reach the right destination. 
 
Bus Topology 
In a bus network communications 
devices are connected to a common channel. There is no central computer and the 
communications devices transmit messages to the other devices. 
 
 

 

 

 

 

 
 
 

iv. Communication Media 
The communication media is the matter or substance that carries the voice or data. 
Many different types of transmission media are currently in use.  All these different 
media types can be grouped into two categories: guided media and radiated 
media. The Guided media are those in which the data flows through physical 
media and the radiated media are those in which the data are broadcast through 
the air. 

Guided Media 

• Twisted-pair wire  
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A twisted-pair wire consists of two insulated copper wires, twisted around each 
other and covered in another layer of plastic insulation  

• Coaxial cable 

 

 

 

 

 

 

A Coaxial cable consists of insulated copper wire wrapped in a metal shield, 
which is then wrapped in an outer external cover. Often many coaxial cables 
are bundled together. 

• Fiber-Optical Cable: consists of hundreds of thin glass wires that transmit 
pulsation beams of light. 

Radiated Media 

• Radio Transmission: Radio transmission use the same basic principle as 
standard radio transmission. When using radio transmission each 
device/computer on the network should be equipped with a radio 
transmitter/receiver on a specific frequency that does not interfere with 
commercial radio stations. The transmitters are very low power and are 
designed typically to transmit a signal to a very short distance, typically up 
to 500 feet. 

• Infrared Transmission: Infrared transmission uses low-frequency light 
waves, below the visible spectrum, to transmit data through the air. Infrared 
transmitters are seldom used to transmit data to and from portable or 
handheld computers. 

• Microwave Transmission: Microwave is a high-frequency beam with short 
wave length. Microwave can be transmitted over a direct line-of-sight path 
between any two points. This transmission medium is typically used for 
long-distance data/voice transmission. 

• Satellite Transmission: In satellite transmission, singles are transmitted to a 
satellite 500 to 22,000 miles is space. One disadvantage of satellite 
transmission is the delay that occurs in transmission, which is known as the 
propagation delay. 
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Data Transmission Types 
In a network data can be transmitted in two different ways, serial transmission 
and in parallel transmission. 

Serial Data Transmission: Bits are transmitted sequentially, one after the other. 

Parallel Data Transmission: Bits are transmitted through separate channels 
simultaneously. 

The standard unit of measure used to specify the speed of the data flow through a 
network is bits per second (bps). 
 

Network Interface Card (NIC) 
 
 

 
 
 
 
 
 
 
 
 

 
 
A network Interface Card provides the physical connection between the computer 
and a network cable and enables access to a network. Most modern computers 
come with NIC cards pre-installed, and ready to be connected to networks. 
 
TYPES OF NETWORKS 

The three basic types of networks include: LAN, MAN and WAN. 

Local Area Network (LAN)  

A network is said to be Local Area Network (LAN) if it is confined relatively to a 
small area. It is generally limited to a building or a geographical area, expanding 
not more than a mile apart to other computers.  

LAN configuration consist of: 

o       A file server - stores all of the software that controls the network, as 
well as the software that can be shared by the computers attached to 
the network. 
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o       A workstation - computers connected to the file server (Mac or 
PCs). These are less powerful than the file server 

o       Cables  - used to connect the network interface cards in each 
computer. 

   

Metropolitan Area Network (MAN)  

Metropolitan Area Network (MAN) covers larger geographic areas, such as cities. 
Often used by local libraries and government agencies often to connect to citizens 

and private industries. 

  Wide Area Network (WAN)  

Wide Area Networks (WANs) connect larger geographic areas, such as London, 
the UK, or the world. In this type of network dedicated transoceanic cabling or 
satellite uplinks may be used. 

Internet 

The Internet is a network of autonomous computer networks that spans the globe. 
It provides an infrastructure for global electronic information exchange. Today the 
Internet is used by millions of people to facilitate various activities such as 
business, education and plain communication. The Internet grew out of a United 
States Department of Defense project, the ARPANET (Advanced Research Project 
Agency Network) started in late 1960s. Its main objective was to provide network 
links between universities, research organizations and remote computer centers. 
 
No person, government or an 
entity owns or controls the 
Internet. Instead, a 
nongovernmental international 
volunteer organization called 
the Internet Society (ISOC) 
controls the standards and the 
future of the Internet. The 
following figure shows how the 
Internet is structured. At the 
bottom level are the 
organizations and home users 
connected to the Internet. 
Typically users connect to the 
Internet through local Internet 
Service Providers (ISPs).  The 
ISPs are in turn connected to 
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the Internet Backbone through regional networks.  Typically ISPs lease high-
bandwidth lines that connect into the Internet and rent that bandwidth to Internet 
users.  
 
 
 
 
Typically a home user (client) connects to the Internet   via telephone lines.  If the 
telephone network is analog a modem is needed in between the computer and the 
telephone line to convert digital signals generated by the computer to analog 
signals that are being transmitted by the telephone network. When a client 
registers with an ISP for Internet usage he will get an account. To access the 
Internet by using this account, the client has to dial the ISP and log on to this 
account. Once logged on, he can access the Internet.  
 
On the Internet information is available mainly through three mediums: the World 
Wide Web (WWW), Usenet News (News) and Electronic Mail (e-mail).  The WWW 
is built on top of the Internet. It can be viewed as a large notice board with posters 
and printed notices stuck to it. On the WWW Web servers provide information on 
the Internet. A user can access the information provided by web browsers by using 
a web browser. 
 
Types of resource available on the Internet. 
Different types of resources are available on the Internet. Some of the common 
types of information available on the Internet are: 

 
• Different types of information such as text, sounds, pictures, and short 

movie clips. 
• Information at all levels -- storybooks and games for children, university 

course materials, business information, fine art, and lots of things that are 
just plain fun. 

• Actual business information -- including electronic shopping malls. 
• Games that you can play alone or with other people all over the world. 

Programs to help you find the information that you want. 
 

v. Internet Browsers 
The information in the WWW is viewed using a Browser such as Netscape 
Navigator or Microsoft Internet Explorer. A browser will provide several means of 
navigating or finding your way around the WWW. It will also provide the means of 
displaying various resources found on the Internet, from HTML hypertext web 
pages to pictures, sounds and movies. Often the browser requires helper or plug-in 
programs to display a particular type of resource, such as QuickTime and 
Shockwave.  
 
 
 
 

ISP’s Computer
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Microsoft Internet Explorer 

 
 

• The window above can be resized and moved by dragging the edge of the 
window. Note that the contents re-arrange themselves to fit the new window 
size.  

• At the top of the window is a toolbar of useful shortcuts such as go back a 
page, go home, reload a page, print a page or stop loading a page. All of 
these commands and other less common ones are also available in the 
menus.  

 
• Below the toolbar is the address bar telling you where this page is stored, 

which will be explained in the section on URLs.  
• Scroll bars let you move up and down a page if it will not all fit on the screen 

at once.  
• The status indicator in the upper right corner animates to show when a 

transfer is in progress. If the icon is changing, then the system is trying to 
get something for you -- just be patient.  

• The status message field (along the very bottom of the window) shows you 
information about a targeted page or a transfer in progress.  

• The progress bar (behind the status message field) fills with colours as a file 
is being transferred. This helps you to tell how much longer you have to wait 
before you get the entire file.  
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Unit two 
Data Representation and Internal Operations of the Computer 
 
2.1 Introduction to Number Systems 
 
Background and history 
 
 Man’s earliest number or counting system was probably developed to help 
determine how many possessions a person had. As daily activities became more 
and more complex, numbers became more important in trade, time, distance, and 
all other phases of human life. As you have seen already, numbers are extremely 
important in your personal life. You realize that you need more than your fingers 
and toes to keep track of the numbers in your daily routine. Ever since people 
discovered that it was necessary to count objects, they have been looking for 
easier ways to count them. The abacus, developed by the Chinese, is one of the 
earliest known calculators. It is still in use in some parts of the world. Blaise Pascal 
(French) invented the first adding machine in 1642. Twenty years later, an 
Englishman, Sir Samuel Moreland, developed a more compact device that could 
multiply, add, and subtract. About 1672, Gottfried Wilhelm von Leibniz (German) 
perfected a machine that could perform all the basic operations (add, subtract, 
multiply, divide), as well as extract the square root. Modern electronic digital 
computers still use von Liebniz's principles. 
 
What is a Number System? 
 
Unit and Number  
 
The terms unit and number when used with the decimal system are almost self-
explanatory by definition. The unit is a single object; that is, an apple, a dollar, a 
day. A number is a symbol representing a unit or a quantity. The figures 0, 1, 2, 
and 3 through 9 are the symbols used in the decimal system. These symbols are 
called Arabic numerals or figures. Other symbols may be used for different number 
systems. For example, the symbols used with the Roman numeral system are 
letters.  V is the symbol for 5, X for 10, M for 1,000, and so forth.  
 

A number is a symbol showing position in a series and a concept of 
quantity 

 
A number system is a definite set of symbols (digits), which can be 
used to represent any value.  

 
This can further be used to do mathematical operations and various other functions 
related to the values they represent. 
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Functions of number systems; 
 Representing values 
 Counting 
 Performing calculations 
 Comparing amounts 
 Determining order. 

There are two types of number systems 

1. Non-positional number systems 

Eg. Roman number systems (I, V, X, C, L, D) – Values are represented 
basically on the symbol  

2. Positional number systems  

Eg. Hindu –Arabic number system(0, 1, 2, 3, 4, 5, 6, 7, 8, 9 etc.) – Values are 
mainly represented on the place value of the symbols For example, the number 
123 has a very different value from the number 321, although the same digits are 
used in both numbers. 
The study of number systems is not just limited to computers. We apply numbers 
every day, and knowing how numbers work will give us an insight into how a 
computer manipulates and stores numbers.  
Inside the computer all the information is handled through two distinct values, ie.0 
and 1. It may be an electronic semiconductor, Magnetic material, Optical device or 
anything which can have two distinct states can be used to represent data in the 
computer. This state of being active or inactive, positive or negative, is generally 
called binary state. In digital data transmission also this binary nature is applied. 
 
Symbolic and place value 
 
. •Weighting Factor 
 The weighting factor is the multiplier value applied to each column position 
of the number. For instance, decimal has a weighting factor of TEN, in that each 
column to the left indicates a multiplication value increase of 10 over the previous 
column on the right, i.e.;  as each column moves to the left, there is an  increase by 
a multiple factor of 10. 
 
      312 = 300 + 10 + 2 
                = 3 * 100 + 1 * 10 + 2 * 1           
         = 3 * 102 + 1 * 101 + 2 * 100  
                                   
         Weighting factors 
•Base Values 
The base value of a number system is the number of different values the set has 
before repeating itself. For example, decimal has a base of ten values, 0 to 9.  
•Binary = 2 (0, 1)  
•Octal = 8 (0 - 7)  
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•Decimal = 10 (0 - 9)  
•Hexadecimal = 16 (0 - 9, A-F)  
Suppose the base of the number system is n. Then the number of Digits or 
symbols of that number system  = n , from 0 to n-1.  
 
• Abacus was the first device which denoted and did operations using   

numbers. 
 
 
2.1.1 Decimal, Binary, Octal, Hexadecimal Number Systems 
 

Decimal Number system 

•This number system uses TEN different symbols to represent values(0-9). The set 
of values used in decimal are; 
  
  0 1 2 3 4 5 6 7 8 9  
 
When representing large values and doing calculations, if the highest digit (9) is 
exceeded, a carry over which is transferred to the next column (to the left) occurs. 
Lets 17+4 
  17 
  18 +1 
  19 +2  
  20 +3 
  21 +4 
When 9 is exceeded, we go back to the beginning of the set (0), and carry a value 
of 1 over to the next column on the left  Each place is raised to the power of 10. 
 
  
 
eg.     3   8   2   0    610 

 

 =      104X3  103X8   +  102 X2    +  101 X  0   + 100  X 6 
  
 = 30000 + 8000 + 200 + 00 + 6 
 
 = 3820610  
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Binary Number system 

A number system with only two digits, i.e. 0 and 1. We can use these two symbols 
to represent any value. 
Decimal notation   Binary notation 
 

0 0 
1 1 
2 10 
3 11 
4 100 
5 101 
6 110 
7 111 
8 1000 
9 1001 
10 1010 
11 1011 
12 1100  
. 

 . 
 . 

31 11111 
32 100000 etc. 

 
Calculation of the value of a Binary number 
 

1  0  1  12 
 

23 x1 + 22 x0  + 21 x1  + 20 

 

8x1 + 4x0  2x1  1x1 
 

8         + 0         + 2 + 1  = 11 
 

10112  = 1110 
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Most Significant Digit(MSD) and Least Significant Digit(LSD)  
 
The first nonzero digit you encounter is the MSD, and the last nonzero digit is the 
LSD. If the number is a whole number, then the first digit to the left of the radix 
point is the LSD. 
 

 
 

 
  

Octal number system 
 
•The octal number system uses EIGHT digits to represent numbers. The 8 distinct 
digits are, 
   0 1 2 3 4 5 6 7  
 
•With 0 having the least value and 7 having the greatest value  
 
•Columns are used in the same way as in the decimal system, in that the left most 
column is used to represent the greatest value  
 
•Octal numbers are represented with a suffix 8 
 
•Each column represents a power of 8,    
  
Eg.        1768  = 1 * 82 + 7 * 81 + 6 * 80         
                          = (1 * 64) + (7 * 8) + (6 * 1)         
          = 64 + 56 + 6 
                           = 12610  
 

 

Hexadecimal number system 
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•The hexadecimal number system uses SIXTEEN values to represent Numbers. 
The 16 distinct values are, 0 1 2 3 4 5 6 7 8 9 A B C D E F, where A = 10, B = 11, 
.., F = 15  
 
•With ‘0’ having the least value and ‘F’ having the greatest value.  
 
•Hexadecimal numbers are represented with the suffix 16. 
•Each column represents a power of 16,    
 17616 = (1 * 162) + (7 * 161) + (6 * 160)        
            = (1 * 256) + (7 * 16 )+ (6 * 1)         
        = 256 + 112 + 6        
  = 37410 
 
 
2.1.2  Conversions between number systems 
 

Decimal into binary conversion 
• Divide the decimal number as far as possible (until you get 1 as 

quotient)  
• Write the remainders starting from the bottom  

 
2510  =  2    25 
 2 12             -    1 
  
         2     6          -    0 
  

2 3        -     0   
 
 1       -   1 
 
 
2510    =  1  1  0   0   1 2 

 
Binary into Decimal - conversion 

 
The place values have to be multiplied by the digit(either 0 or 1) 
and the results added.    

 
1 0 0 1 1 The  binary number 

2^4 2^3 2^2 2^1 2^0 Place values 

 

As such the binary number 10011 represents the value 
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  (1 * 2^4) + (0 * 2^3) + (0 * 2^2) + (1 * 2^1) + (1 * 2^0) 

                    

= 16 + 0 + 0 + 2 + 1 

= 19 

 
1 1 0 1 1 2 (binary) 
24+23+0+21+20  = 16+8+0+2+1 
                             = 2710 (decimal) 

and 

1 0 1 1 0 1 0 1 2 (binary) 
27+0+25+24+0+22+0+20 = 128+0+32+16+0+4+0+1 
                                        = 18110 (decimal) 

 
Decimal to Octal - Conversion  
 
Repeated Division by 8  
 

177/8    = 22+ remainder of 1            1 (Least Significant Bit) 

22/ 8     = 2 + remainder of 6             6 

2 / 8       = 0 + remainder of 2            2 (Most Significant Bit) 

Result       17710    =  2618 

Octal to Decimal - Conversion 

eg. 24.68 = 2 x (81) + 4 x (80) + 6 x (8-1) = 20.7510 

 
Binary-To-Octal / Octal-To-Binary Conversion 
 

Octal Digit 0 1 2 3 4 5 6 7 
Binary Equivalent 000 001 010 011 100 101 110 111 

Each Octal digit is represented by three bits or binary digits. 

eg. 100 111 0102 = (100) (111) (010)2 = 4 7 28 
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Hexadecimal to Decimal Conversion 

The hexadecimal system uses base 16. Thus, it has 16 possible digit 
symbols. It uses the digits 0 through 9 plus the letters A, B, C, D, E, and F 
as the 16 digit symbols. 

163 162 161 160  16-1 16-2 16-3 
=4096 =256 =16 =1 . =1/16 =1/256 =1/4096 
Most 
Significant 
Digit 

   Hexadec. 
point   

Least 
Significant 
Digit 

 

eg. 2AF16 = 2 x (162) + 10 x (161) + 15 x (160) = 68710 

Convert decimal to hexadecimal   

Repeat Division 
This method uses repeated division by 16. Eg. convert 37810 to hexadecimal 
and binary: 

378/16  = 23+ remainder of 10 A (Least Significant Bit) 
23/ 16  = 1 + remainder of 7 7 
1 / 16  = 0 + remainder of 1  1 (Most Significant Bit) 
Result 37810 =  17A 

 Convert to Binary 
= 0001 0111 10102 
= 0000 0001 0111 1010 (16 
bits) 

Binary-To-Hexadecimal /Hexadecimal-To-Binary Conversion 

To convert a binary number into the hexadecimal equivalent; 

1. First, group the bit string into four digits 
2. Then, write the equivalent decimal value for each four digit set 
3. If the number is greater than 9, assign A to F (from 10 to 15) 

Each Hexadecimal digit is represented by four bits of binary digit. 

eg. 1011 0010 11112 = (1011) (0010) (1111)2 = B 2 F16 

 

A hexadecimal number can be written in binary numbers directly. 
Write in four digit groups. 
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A408F16 

A = 10 = 1010  4= 0100 0= 0000 8= 1000 
 F=15=1111 

So;  A408F16  = 101001000000000111112 

 

Hexadecimal Digit 0 1 2 3 4 5 6 7 
Binary Equivalent 0000 0001 0010 0011 0100 0101 0110 0111
 
Hexadecimal Digit 8 9 A B C D E F 
Binary Equivalent 1000 1001 1010 1011 1100 1101 1110 1111

 

Questions: 

What is a number?  1). A quantity of objects     2).A counting system based 
on symbols      3).The decimal system    4). A symbol 
representing a unit or a  quantity 

A number system uses the symbols 0 through 4. What is its base?  

1). 6  2). 5  3). 3  4). 4 

Which of the following symbols is NOT an Arabic figure?  

1). C  2). 2  3). 7  4). 9 

To which power of ten the 1 in 157210 is equal to?  

1). 101   2). 102   3). 103   4). 104 
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2.2 Data Representation 

2.2.1 Bites and Bytes 

As you know, the fundamental unit of data within a computer system is a BInary 
digit, or BIT. A bit is the smallest element of information used by a computer. A bit 
holds ONE of TWO possible values,  

Value Meaning 
0  OFF  
1  ON  

A bit which is OFF is also considered to be FALSE or NOT SET; a bit which is ON 
is also considered to be TRUE or SET.  

Because a single bit can only store two values, bits are combined together into 
large units in order to hold a greater range of values 

Other terms connected to bits are:- 
 
 BYTE - which is a group of eight bits.  
 KILOBYTE - which is 1024 bytes. 
 MEGABYTE - which is 1024 kilobytes. 
 GIGABYTE   - which is 1024 megabytes  
 TERABYTE  - - which is 1024 gigabytes etc. 
 
Because the computer is a binary machine, all the information it deals with directly 
must be stored and represented as binary. This in turn is represented 
electronically, at the hardware level, as high and low voltages - a high for a binary 
1 and a low for a binary 0. 
 
When data are stored in a binary machine it may be stored serially - as on the 
tracks of a disk, or it may be stored in a parallel fashion - as in the main memory 
of the computer.  
 
When data are stored serially it is usually much slower to access, but is more 
efficient in terms of cost. Conversely, when it is stored  parallel, it is accessed 
faster, but uses devices which generally cost much. Additionally, because parallel 
access requires a greater number of signal paths, the devices use more resources 
anyway. 
 
Data come in many different forms:- numbers, alphanumeric characters (letters, 
numbers, and punctuation marks), control codes, communication codes and so on, 
all of which may be represented in binary. 
 
If, for example, we take the binary value:- 01100011, which is a single byte of data, 
then this may be used to represent various different things to a computer system 
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depending upon whether the machine is currently processing numbers, instructions 
or alphanumeric characters.  
 
The machine is programmed internally to know the difference between the 
various data types at the moment of processing. 
 
In our example above, the binary value could be used either to represent the 
binary equivalent of 99, or it could be used to represent the character ‘c’ in ASCII. 
 
ASCII stands for American Standard Code for Information Interchange, and is the 
accepted standard for representing alphanumeric data. That is, each letter, number 
and punctuation mark has an ASCII code, and this is “understood” by input/output 
devices like the screen and keyboard which are connected to our computer 
systems. 
 

2.2.2 ASCII and BCD  

ASCII (American Standard Code for Information Interchange) 

American Standard Code for Information Interchange. Usually refers to the 
coding system that assigns numerical values to characters such as letters, 
numbers, punctuation marks, and other symbols. Basic ASCII allows only 7 
bits per character (for a total of 128 characters). The first 32 characters are 
"unprintable" (line feed, form feed, etc.). Extended ASCII adds an additional 
128 characters that vary between computers, programs and fonts 

ASCII Table (7-bit) 
(ASCII = American Standard Code for Information Interchange) 
 
       Decimal   Octal   Hex    Binary     Value 
       -------   -----   ---    ------     ----- 
         000      000    000   00000000      NUL    (Null char.) 
         001      001    001   00000001      SOH    (Start of Header) 
         002      002    002   00000010      STX    (Start of Text) 
         003      003    003   00000011      ETX    (End of Text) 
         004      004    004   00000100      EOT    (End of Transmission) 
         005      005    005   00000101      ENQ    (Enquiry) 
         006      006    006   00000110      ACK    (Acknowledgment) 
         007      007    007   00000111      BEL    (Bell) 
         008      010    008   00001000       BS    (Backspace) 
         009      011    009   00001001       HT    (Horizontal Tab) 
         010      012    00A   00001010       LF    (Line Feed) 
         011      013    00B   00001011       VT    (Vertical Tab) 
         012      014    00C   00001100       FF    (Form Feed) 
         013      015    00D   00001101       CR    (Carriage Return) 
         014      016    00E   00001110       SO    (Shift Out) 
         015      017    00F   00001111       SI    (Shift In) 
         016      020    010   00010000      DLE    (Data Link Escape) 
         017      021    011   00010001      DC1 (XON) (Device Control 1) 
         018      022    012   00010010      DC2       (Device Control 2) 
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         019      023    013   00010011      DC3 (XOFF)(Device Control 3) 
         020      024    014   00010100      DC4       (Device Control 4) 
         021      025    015   00010101      NAK    (Negative Acknowledgement) 
         022      026    016   00010110      SYN    (Synchronous Idle) 
         023      027    017   00010111      ETB    (End of Trans. Block) 
         024      030    018   00011000      CAN    (Cancel) 
         025      031    019   00011001       EM    (End of Medium) 
         026      032    01A   00011010      SUB    (Substitute) 
         027      033    01B   00011011      ESC    (Escape) 
         028      034    01C   00011100       FS    (File Separator) 
         029      035    01D   00011101       GS    (Group Separator) 
         030      036    01E   00011110       RS    (Request to Send)(Record Separator) 
         031      037    01F   00011111       US    (Unit Separator) 
         032      040    020   00100000       SP    (Space) 
         033      041    021   00100001        !    (exclamation mark) 
         034      042    022   00100010        "    (double quote) 
         035      043    023   00100011        #    (number sign) 
         036      044    024   00100100        $    (dollar sign) 
         037      045    025   00100101        %    (percent) 
         038      046    026   00100110        &    (ampersand) 
         039      047    027   00100111        '    (single quote) 
         040      050    028   00101000        (    (left/opening parenthesis) 
         041      051    029   00101001        )    (right/closing parenthesis) 
         042      052    02A   00101010        *    (asterisk) 
         043      053    02B   00101011        +    (plus) 
         044      054    02C   00101100        ,    (comma) 
         045      055    02D   00101101        -    (minus or dash) 
         046      056    02E   00101110        .    (dot) 
         047      057    02F   00101111        /    (forward slash) 
         048      060    030   00110000        0 
         049      061    031   00110001        1 
         050      062    032   00110010        2 
         051      063    033   00110011        3 
         052      064    034   00110100        4 
         053      065    035   00110101        5 
         054      066    036   00110110        6 
         055      067    037   00110111        7 
         056      070    038   00111000        8 
         057      071    039   00111001        9 
         058      072    03A   00111010        :    (colon) 
         059      073    03B   00111011        ;    (semi-colon) 
         060      074    03C   00111100        <    (less than) 
         061      075    03D   00111101        =    (equal sign) 
         062      076    03E   00111110        >    (greater than) 
         063      077    03F   00111111        ?    (question mark) 
         064      100    040   01000000        @    (AT symbol) 
         065      101    041   01000001        A 
         066      102    042   01000010        B 
         067      103    043   01000011        C 
         068      104    044   01000100        D 
         069      105    045   01000101        E 
         070      106    046   01000110        F 
         071      107    047   01000111        G 
         072      110    048   01001000        H 
         073      111    049   01001001        I 
         074      112    04A   01001010        J 
         075      113    04B   01001011        K 
         076      114    04C   01001100        L 
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         077      115    04D   01001101        M 
         078      116    04E   01001110        N 
         079      117    04F   01001111        O 
         080      120    050   01010000        P 
         081      121    051   01010001        Q 
         082      122    052   01010010        R 
         083      123    053   01010011        S 
         084      124    054   01010100        T 
         085      125    055   01010101        U 
         086      126    056   01010110        V 
         087      127    057   01010111        W 
         088      130    058   01011000        X 
         089      131    059   01011001        Y 
         090      132    05A   01011010        Z 
         091      133    05B   01011011        [    (left/opening bracket) 
         092      134    05C   01011100        \    (back slash) 
         093      135    05D   01011101        ]    (right/closing bracket) 
         094      136    05E   01011110        ^    (caret/cirumflex) 
         095      137    05F   01011111        _    (underscore) 
         096      140    060   01100000        ` 
         097      141    061   01100001        a 
         098      142    062   01100010        b 
         099      143    063   01100011        c 
         100      144    064   01100100        d 
         101      145    065   01100101        e 
         102      146    066   01100110        f 
         103      147    067   01100111        g 
         104      150    068   01101000        h 
         105      151    069   01101001        i 
         106      152    06A   01101010        j 
         107      153    06B   01101011        k 
         108      154    06C   01101100        l 
         109      155    06D   01101101        m 
         110      156    06E   01101110        n 
         111      157    06F   01101111        o 
         112      160    070   01110000        p 
         113      161    071   01110001        q 
         114      162    072   01110010        r 
         115      163    073   01110011        s 
         116      164    074   01110100        t 
         117      165    075   01110101        u 
         118      166    076   01110110        v 
         119      167    077   01110111        w 
         120      170    078   01111000        x 
         121      171    079   01111001        y 
         122      172    07A   01111010        z 
         123      173    07B   01111011        {    (left/opening brace) 
         124      174    07C   01111100        |    (vertical bar) 
         125      175    07D   01111101        }    (right/closing brace) 
         126      176    07E   01111110        ~    (tilde) 
         127      177    07F   01111111      DEL    (delete) 
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BCD (Binary Coded Decimal) Number System 
 
You should now be familiar with the Binary, Decimal and Hexadecimal Number 
System. If we view single digit values for hex, the numbers 0 - F, they represent 
the values 0 - 15 in decimal, and occupy a nibble. Often, we wish to use a binary 
equivalent of the decimal system. This system is called Binary Coded Decimal or 
BCD which also occupies a nibble. In BCD, the binary patterns 1010 through 1111 
do not represent valid BCD numbers, and cannot be used. 
 
Conversion from Decimal to BCD is straightforward. You merely assign each digit 
of the decimal number to a byte and convert 0 through 9 to 0000 0000 through 
0000 1001, but you cannot perform repeated division by 2 as you did to convert 
decimal to binary. 
 
Let us see how this works. Determine the BCD value for the decimal number 
5,319. Since there are four digits in our decimal number, there are four bytes in our 
BCD number. They are: 

Thousands Hundreds Tens Units 

5 3 1 9 

0 0 0 0 0 1 0 1 0 0 0 0 0 0 1 1 0 0 0 0 0 0 0 1 0 0 0 0 1 0 0 1 
 
Since computer storage requires a minimum of 1 byte, you can see that the upper 
nibble of each BCD number is wasted storage. BCD is still a weighted position 
number system so that you may perform mathematics, but we must use special 
techniques in order to obtain a correct answer. 
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2.3 Logic gates and circuits 

2.3.1 Logic Gates 

A logic gate is an arrangement of switches used to calculate operations in Boolean 
algebra. It is an elementary building block in a digital circuit. Most logic gates have 
two inputs and one output. At any given moment, every terminal is in one of the 
two binary conditions low (0) or high (1), represented by different voltage levels. 
The logic state of a terminal can, and generally does, change often, as the circuit 
processes data.  

In most logic gates, the low state is approximately zero volts (0 V), while the high 
state is approximately five volts positive (+5 V). 

Computers operate on the principle of logic and use the TRUE and FALSE logic 
conditions of a logical statement to make a programmed decision. The conditions 
of a statement can be represented by symbols or variables.  

In computers, electronic circuits operating in two LOGIC STATES represent these 
two conditions. These logic states are 0 (zero) and 1 (one). 0 and 1 represent the 
FALSE and TRUE conditions of a statement, respectively. 

There are five basic logic gates: AND, OR,  NOT, NAND and NOR. 

2.3.1.1  The AND gate 

The AND gate has two or more inputs. The output from the AND gate is 1 if and 
only if all of the inputs are 1, otherwise the output from the gate is 0. The AND gate 
is drawn as follows  

 

 

The output from the AND gate is written  .  

Truth table 

A table that defines a logic circuit by listing all combinations of input values, and 
indicating the  true output values for each combination. 

 

The truth table for a two-input AND gate looks like  
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0  0  0 

0  1  0 

1  0  0 

1  1  1 

It is also possible to represent an AND gate with a simple analogue circuit, where a 
bulb is lit when A and B are closed. 

 

 

2.3.1.2 The OR gate 

The OR gate has two or more inputs. The output from the OR gate is 1 if any of the 
inputs is 1. The gate output is 0 if and only if all inputs are 0. The OR gate is drawn 
as follows  

 

 

The output from the OR gate is written  .  

The truth table for a two-input OR gate looks like  
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0  0  0 

0  1  1 

1  0  1 

1  1  1 

 

The following diagram represents an OR gate with a simple analogue circuit, 
where a bulb is lit when A or B is closed. 

 

2.3.1.3  The NOT gate 

The NOT gate is unique in that it has only has one input. This is how it looks   

 

 

The input to the NOT gate is inverted i.e the binary input state of 0 gives an 
output of 1 and the binary input state of 1 gives an output of 0.  
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is known as "NOT A" or alternately, the complement of .  

The truth table for the NOT gate appears as below  

 

0  1 

1  0 

 

2.3.2  Combination of gates  

These three gates are adequate to accomplish all possible logical functions and 
operations in the microprocessor. 

Some combinations of the three basic AND, OR and NOT gates are used so 
commonly that they have been given names and logic symbols of their own. i.e. 
NAND, NOR, these gates are constructed using basic AND, OR and NOT gates. 

2.3.2.1 The NAND (NOT AND) Gate  

A simple circuit consisting of an AND gate in series with an inverter is illustrated 
below.  

  

 
              . 
This simple circuit is referred to as a NAND gate because the output is a NOT AND 
output. The circuit  has its own symbol as illustrated below. 
 

 
A NAND gate is cheaper to manufacture as a single circuit on a chip compared to 
the cost of manufacturing an AND gate and a NOT gate using separate circuits on 
separate chips. In fact microprocessors mostly use NAND gates because of their 
relatively low cost.  
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Truth Table for a NAND Gate 
A B   AB 

0 0 1 

0 1 1 

1 0 1 

1 1 0 

 
   

The NAND gate can be considered to have the NOT AND function. The outputs for 
a NAND gate are the complements or inversions of the corresponding outputs for 
an AND gate. 
   
As with an AND gate, there is no limit to the number of inputs that may be applied 
to a NAND function, as such, there is no functional limit to the number of inputs a 
NAND gate may have. However, for practical reasons, commercial NAND gates 
are most commonly manufactured with 2, 3, or 4 inputs, to fit in a 14-pin or 16-pin 
package. In the diagram below, four separate 2 input NAND gates are wired in a 
chip containing 14 pins. 

 
 
Note that there is no separate symbol for NAND in Boolean logic.  Using symbols, 
the AND function is designated with a multiplication sign (.), or usually no sign, with 
an overbar over the entire expression to indicate the NAND function. 
 
For example, using symbols, can be read as NAND AB, although this is usually 
read as NOT AB or NOT A AND B. 
Here is a 14 pin integrated circuit chip containing three input NAND gates.  The 
truth table for a          3-input NAND gate is also listed below. 
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14-pin IC chip 

 
A B C ABC  
0 0 0 0 1 
0 0 1 0 1 
0 1 0 0 1 
0 1 1 0 1 
1 0 0 0 1 
1 0 1 0 1 
1 1 0 0 1 
1 1 1 0 1 

 
The truth table for a  3-input NAND gate for the circuit above. 

 
 

2.3.2.2 The NOR (NOT OR) Gate 

We saw above that an AND gate in series with an inverter [NOT gate] is referred to 
as a NAND gate. 
Similarly, an OR gate in series with an inverter [NOT gate] is referred to as a NOT 
OR or simply, NOR gate.  
 
An OR gate in series with an inverter: is called a NOR gate which has its own 
special symbol: 

 
 

 
 
 
 
The NOR gate is an OR gate where the output is inverted. There is no separate 
Boolean symbol for NOR. 
In symbols, the NOR function is designated by a plus sign (+), with an overbar over 
the entire expression to indicate the inversion. In logical diagrams, the symbol 
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read as NOT A OR B or simply A NOR B which represents the output of a 2-
input NOR gate. 
 
A NOR gate can have any number of inputs, but practical commercial NOR gates 
are mostly limited to 2, 3, and 4 inputs, as with other gates at this level, to fit into 
standard IC packages.  
The Motorola MC14025B 14 pin chip is shown below. This chip contains three 3-
input NOR gates. The truth table for each gate has also been completed as shown 
below. 
 
 

 
 

A B C A + B + C  
0 0 0 0 1 
0 0 1 1 0 
0 1 0 1 0 
0 1 1 1 0 
1 0 0 1 0 
1 0 1 1 0 
1 1 0 1 0 
1 1 1 1 0 

 
 
These gates, as with the other derived logic gates, can be formed from a 
combination of the three basic gates: AND, OR and NOT. However, because of 
their functional importance, these gates again are treated as basic gates along with 
their own unique symbols. 
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Design simple circuits  

 
Example 

 
 
 
Write the Boolean equation for the following 

 

 

Input Intermediate Values Output 

A B 
     

0 0 1 1 0 0 0 
0 1 1 0 1 0 1 
1 0 0 1 0 1 1 
1 1 0 0 0 0 0 

 A 

B

A B

AB

AB+AB

 A B A B AB AB+AB
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2.4.0 Boolean Algebra 

 

 

Algebra is branch of mathematics which describes basic arithmetic relations using 
variables. When numbers are in binary form, the algebra that deals with these is 
called Boolean Algebra. George Boole the famous mathematician has developed 
this further.  

Normally algebra consists of numbers and a set of basic rules called axioms. An 
axiom is an initial rule or statement that is accepted as true without proof.  
Theorems can be derived using axioms. 

Boolean arithmetic 
Exploration of Boolean algebra by adding numbers together:  
          0 + 0 = 0 
          0 + 1 = 1 
          1 + 0 = 1 
          1 + 1 = 1 
 
        0  0 = 0 
        0  1 = 0 
        1  0 = 0 
        1  1 = 1 
 
The following diagram shows how axioms are derived. 
 

Derive    X + 0 = X 
               X + X = X 
  X + 1 =  1   

 X + X = 1 
Derive    0 . X = 0 
                X . X = X 
   X . 1 =  X 
  

   X . X = 0 
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X + X = X, axiom is derived from the two diagrams above  
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Axiom X + X = 1    is derived, from the two diagrams above. 

Multiplication is valid in Boolean algebra, and fortunately it is the same as in real-
number algebra: Anything multiplied by 0 is 0, and anything multiplied by 1 remains 
unchanged:  

 

 

This is the same pattern found in the truth table for an AND gate. In other words, 
Boolean multiplication corresponds to the logical function of an "AND" gate, as well 
as in switch contacts in series., 

 

Axiom 0 . X = 0, is derived from the two diagrams above 
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Axiom. 1 . X = X, derived from the two diagrams above. 

Boolean algebra uses capital letters to denote variables. A variable is allowed to 
possess only one of two possible values, either 1 or 0, each and every variable has 
a complement: Boolean notation uses a bar above the variable character to denote 
complementation, like this: 

 

In written form, the complement of "A" is denoted as "A-not" or "A-bar". Sometimes 
a "prime" symbol is used to represent complementation.  
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Multivariable Theorems 

The theorems presented below involve more than one variable:  
 

9. x + y = y + x (commutative law)  
10. x * y = y * x (commutative law)  
11. x+ (y+z) = (x+y) +z = x+y+z (associative law)  
12. x (yz) = (xy) z = xyz (associative law) 
13.  

a. x (y+z) = xy + xz 
 b.(w+x)(y+z) = wy + xy + wz + xz  

14. x + xy = x  
15. x + x'y = x + y 

 
Choose the correct answers in the following questions. 

What function are implemented by the following circuits shown below 
1.  

 
 
 
 

2.  
 

 
 

3.  

  
  
 

DeMorgan's theorems 
DeMorgan's theorems are extremely useful in simplifying expressions in 
which a product or sum of variables is inverted. 
 
 The two theorems are: 
(16) (x+y)' = x' * y' 
(17) (x*y)' = x' + y' 
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Theorem (16) says that when the OR sum of two variables is inverted, this 
is the same as inverting each variable individually and then AND  in these 
inverted variables.  
 
Theorem (17) says that when the AND product of two variables is inverted, 
this is the same as inverting each variable individually and then OR  in 
them. 
 
Implications of DeMorgan's Theorem 
 
For (16): (x+y)' = x' * y' 
 

  
 
 
 

 

For (17): (x*y) = x + y 

 
 
 
 
 

 
 
Any logic circuit, no matter how complex, may be completely described 
using the Boolean operations, because the OR gate, AND gate, and NOT 
circuit are the basic building blocks in digital systems.  

This is an example of a circuit using Boolean expression 
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Whenever an INVERTER is present in a logic-circuit diagram, its output expression 
is simply equal to the input expression with a bar ( - ) over it.  

 

 

Creating Circuits using Boolean Expression 

If the operation of a circuit is defined by a Boolean expression, a logic-circuit 
diagram can he implemented directly from that expression. 

Suppose we wanted to construct a circuit whose output is y = AC+BC + ABC. This 
Boolean expression contains three terms (AC, BC, ABC), which are OR  together. 
This tells us that a three-input OR gate is required with inputs that are equal to AC, 
BC, and ABC, respectively.  

Each OR-gate input is an AND product term, which means that an AND gate with 
appropriate inputs can be used to generate each of these terms. Note the use of 
an INVERTER to produce the A and C terms required in the expression. 

 

1) Boolean Logic uses _________ to determine how bits are compared and 
simulate ________ .  

A) Operators, Gates  
B) Buffers, AND  
C) Truth Tables, Off  
D) NOR, NAND  

AB

A+B

A

A

A+D

ABC

(A+D)

X=ABC(A+D)
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2) The _______ operation says if and only if all inputs are on, the output will be on. 
The output will be off if any of the inputs are off.  

A) OR  
B) NAND  
C) NOR  
D) AND  

3) The ______ operation says if any input is on then the output will be on.  

A) NOT  
B) OR  
C) NOR  
D) XOR  

4) If all of the inputs are on, the output will be off. This is called _______.  

A) NAND  
B) NOR  
C) Truth Tables  
D) On  

5) This operation says that if any input is on, the output will be off. Which operation 
is this?  

A) Boolean Logic  
B) XOR  
C) NOR  
D) AND  

6) ________ says that if the inputs are different then the output will be on.  

A) Gates  
B) Low  
C) NXOR  
D) XOR  

7) ________ simply changes the input to the opposite (0 to 1 or 1 to 0).  

A) Operator  
B) NOT  
C) AND  
D) OR  

Answers 

1. A) Operators, Gates  
2. D) AND  
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3. B) OR  
4. A) NAND  
5. C) NOR  
6. D) XOR  
7. B) NOT  

 

References:- 

• http://www.eelab.usyd.edu.au/digital_tutorial/chapter4/4_0.html 
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• http://www.sweetscape.com/010editor/manual/NumberSystems.ht
m 

 
• http://www.dotlessbraille.org/numbersystems.htm 
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Unit 3: Generic Software 

3.1         Word processing, desktop publishing 

3.1.1   Introduction to word processing, desktop publishing and 
graphics software 

 

Introduction to word processing 

A Word processing package is one of the application software packages which 
helps us to prepare documents with texts, graphics, and images.. etc . There are 
many kinds of word processing packages.  

Eg. 
1.Word pro 

2.word star 

3.word perfect 

4. Ms word 98/2000/xp/2003  

Introduction to Ms word  

Ms Word  is an advanced word processing product by Microsoft. Ms Word  is a 

major upgrade to an already fully featured package, apart from integrating 

information from non-Word programs like spread sheet  , data bases, graphic 

sources etc . Ms Word  has added many internet   based facilities like E-mail, 

designing web pages etc.  

Ms Word  gives you tools to create professional quality documents and share 

information easily. This new version of word is loaded with helpful, time saving 

features that will allow you to focus on the content of your documents rather than 

on how to use the software. Word automatically determines what language a user 

is typing and applies the correct proofing tools like auto correct, spell checker, 

grammar check etc. 
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Introduction to  desktop publishing  

Desktop publishing is the process of using the computer and specific types of 
software to combine texts and graphics to produce documents. Desktop publishing 
can be used to prepare forms, magazines, reports, advertisements, brochures, 
leaflets, books, newsletters, manuals and posters etc…. 
Desktop publishing software is a tool for both graphic designers and non- graphic 
designers to create  visual communication for professional or desktop printing. 
 
Eg. 

• Corel draw 
• Page maker 
• Publisher 
• Photoshop 

Getting started to Ms word  

Let’s work with Ms word 2000. 

You can use any of the following ways to open Ms word 2000 

1. Start-programs-ms office-ms word, or 
2. Double click on the ms word icon on the desk top, or 
3. Right click on the ms word icon on the desk top and click open. 

Screen Layout 
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Menus 

The menus in Word 2000 display only the commands you have recently used.  To 
view all options in each menu, you must click the double arrows at the bottom of 
the menu. The images below show the Format menu collapsed (left) and expanded 
(right) after the double arrows at the bottom of the menu were clicked: 

 

 

 

 

 

 

Shortcut Menus 

View shortcut menus by right clicking with the mouse to be faster than using the 
options on the menu bar. The options on this menu will vary depending on the 
element that was right-clicked. For example, right clicking on a bulleted list 
produces the shortcut menu below.  

 

 

 

 

 

"Decrease Indent" and "Increase Indent" are only applicable to lists and therefore 
only appear on the list shortcut menu. The shortcut menus are helpful because 
they only display the options that can be applied to the item that was right-clicked 
and, therefore, prevent searching through the many menu options. 
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Toolbars 

Many toolbars displaying shortcut buttons are also available to make editing and 
formatting quicker and easier. Select View| Toolbars from the menu bar to select 
the toolbars. The toolbars that are already displayed on the screen are checked. 
Add a toolbar simply by clicking on the name. 

 

 

 

 

 

 

 

 

 

Create a New Document  

 Click the New Document button on the tool bar. , or 
 Choose File| New from the menu bar, or 
 Press CTRL+N (depress the CTRL key while pressing "N") on the 

keyboard.  

 

 

 

 

 

 

This is the new document window. 
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Typing Text 

To enter text, just start typing! The text will appear where the blinking cursor is 
located. Move the cursor by using the arrow buttons on the keyboard or positioning 
the mouse and clicking the left button. The keyboard shortcuts listed below are 
also helpful when moving through the text of a document: 

Cursor movement 
To go to the previous character Left Arrow 
To go to the next character Right Arrow 
To go to the upper character Up Arrow 
To go to the below character Down Arrow 
To go to the beginning of the next word Ctrl+ Right  Arrow  
To go to the beginning of the previous  word Ctrl+ Left  Arrow  
To go to the beginning of the paragraph Ctrl+ up Arrow  
To go to the beginning of the next paragraph Ctrl+ down Arrow  
Go to beginning of line HOME 
Go to end of line END 
Go to beginning of document CTRL+Home 
Go to end of document CTRL+End 

Selecting Text 

To change any attributes of text it must be highlighted first. Select the text by 
dragging the mouse over the desired text while keeping the left mouse button 
depressed, or hold down the SHIFT key on the keyboard while using the arrow 
buttons to highlight the text. The following table contains shortcuts for selecting a 
portion of the text: 

Selection Technique 
Whole word double-click within the word 
Whole paragraph triple-click within the paragraph 
Several words or 
lines 

drag the mouse over the words, or hold down SHIFT 
while using the arrow keys 

Entire document choose Edit|Select All from the menu bar, or press 
CTRL+A 

Selection Technique 
Whole word double-click within the word 
Whole paragraph triple-click within the 

paragraph 
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Deselect the text by clicking anywhere outside of the selection on the page or 
press an arrow key on the keyboard. 

Deleting Text 

Use the BACKSPACE and DELETE keys on the keyboard to delete text. 
Backspace will delete text to the left of the cursor and Delete will erase text to the 
right. To delete a large selection of text, highlight it using any of the methods 
outlined above and press the DELETE key.  

Undo     ctrl+z 
Feel free to experiment with various text styles. You can always undo your last 
action by clicking the Undo button on the standard toolbar or selecting Edit 
|Undo... from the menu bar. Click the Redo button on the standard toolbar or 
select  
Edit| Redo(ctrl+y)... to erase the undo action. 

Moving (Cutting) Text  

Highlight the text that will be moved and select Edit|Cut from the menu bar, click 
the Cut button on the standard tool bar, or press CTRL+X at once. This will move 
the text to a clip board .To move a small amount of text a short distance, the drag-
and-drop method may be quicker. Highlight the text you want to move, click the 
selection with the mouse, drag the selection to the new location, and release the 
mouse button. 

Copying Text  

To copy text, choose Edit|Copy, click the Copy button on the standard toolbar, or 
press CTRL+C to copy the text to the clipboard. 

Paste Text  

To paste cut or copied text, move the cursor to the location you want to move the 
text to and select Edit| Paste from the menu bar, click the Paste button on the 
standard toolbar, or press CTRL+V.  

The Clipboard 

The last 12 elements that were cut or copied are placed onto Word's clipboard. 
You can view the elements on the clipboard by selecting View |Toolbars |Clipboard 
from the menu bar. 
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Place the mouse arrow over each element in the clipboard to view the contents of 
each item and click on an element to add its contents to the document. Click Paste 
All to add all of the items to the document at once. Click the Clear Clipboard 
button (the icon with an "X" over the clipboard image) to clear the contents of the 
clipboard. 

Save a Document  

 Click the Save button on the menu bar. , or 
 Select File| Save from the menu bar, or 
 Press CTRL+S on the keyboard.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Type the name of the document and save in the suitable folder  
 
 
 
Close a Document  
Close the current document by selecting File|Close or click the Close icon if it's 
visible on the Standard Toolbar.  
 
 
 
Open an Existing Document  

 Click the Open File button on the tool bar.  ,or 
 Choose File |Open from the menu bar, or 
 Press CTRL+O on the keyboard. Each method will show the Open dialog 

box. Choose the file and click the Open button.  
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. 

 

 

 

 

 

 3.1.2 Formatting a document, working with graphics and drawing 
objects, creating and customizing tables 

Formatting Text 

The formatting toolbar is the easiest way to change many attributes of text. If the 
toolbar as shown below isn't displayed on the screen, select View|Toolbars and 
choose Formatting. 

 

 Font Face - Click the arrowhead to the right of the font name box to view 
the list of fonts available. Scroll down to the font you want and select it by 
clicking on the name once with the mouse. 

 Font Size - Click on the white part of the font size box to enter a value for 
the font size or click the arrowhead to the right of the box to view a list of 
font sizes available. Select a size by clicking on it once.  

 Font Style - Use these buttons to bold, italicize, and underline text. 
 Alignment - Text can be aligned to the left, center, or right side of the page 

or it can be justified across the page.  
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 Numbered and Bulleted Lists - Lists are explained in detail later in this 
tutorial.  

 Increase/Decrease Indent - Change the indentation of a paragraph in 
relation to the side of the page. 

 Outside Border - Add a border around a text selection. 
 Highlight Color - Use this option to change the color behind a text 

selection. The color shown on the button is the last color used. To select a 
different color, click the arrowhead next to the image on the button. 

 

 Text Color - This option changes the color of the text. The color shown on 
the button is the last color chosen. Click the arrowhead next to the button 
image to select another color. 

 

 The Font dialog box allows you to choose from a larger selection of 
formatting options. Select Format |Font from the menu bar to access the 
box.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Format Painter  
A handy feature for formatting text is the Format Painter located on the standard 
toolbar. For example, if you have formatted a paragraph heading with a certain font 
face, size, and style and you want to format another heading the same way, you do 
not need to manually add each attribute to the new headline. Instead, use the 
Format Painter by following these steps:  



                                            
           National Institute of Education 

81

 Place the cursor within the text that contains the formatting you want to 
copy.  

 Click the Format Painter button in the standard toolbar. Notice that your 
pointer now has a paintbrush beside it.  

 Highlight the text you want to add the same format to with the mouse and 
release the mouse button.  

To add the formatting to multiple selections of text, double-click the Format 
Painter button instead of clicking once.  The format painter then stays active until 
you press the ESC key to turn it off.  
 

Paragraph Attributes 

Format a paragraph by placing the cursor within the paragraph and selecting  

 
Format /Paragraph from the menu bar. 

 

 

 

 

 

 

 

 

 

 

Columns  

To quickly place text in a column format, click the Columns button on the standard 
toolbar and select the number of columns by dragging the mouse over the 
diagram. 

For more column options, select Format |Columns from the menu bar. The 
Columns dialog box allows you to choose the properties of the columns. Select 
the number and width of the columns from the dialog box. 
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Drop Caps 

A drop cap is a large letter that begins a paragraph and drops through several lines 
of text as shown below.  

Add a drop cap to a paragraph by following these steps: 

 Place the cursor within the paragraph whose first letter will be dropped.  
 Select Format| Drop Cap from the menu bar.  
 The Drop Cap dialog box allows you to select the position of the drop cap, 

the font, the number of lines to drop, and the distance from the body text.  
 Click OK when all selections have been made.  
 To modify a drop cap, select Format|  Drop Cap again to change the 

attributes, or click on the letter and use the handles to move and resize the 
letter.  

 

 

 

 

 

 

 

 

To create a bulleted or numbered list, use the list features provided by Word.  
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Bulleted and Numbered Lists  

 Click the Bulleted List button or Numbered List button on the 
formatting toolbar.  

 Type the first entry and press ENTER.  This will create a new bullet or 
number on the next line. If you want to start a new line without adding 
another bullet or number, hold down the SHIFT key while pressing ENTER.  

 Continue to typing entries and press ENTER twice when you are finished 
typing to end the list.  

Use the Increase Indent and Decrease Indent buttons on the formatting 
toolbar to create lists of multiple levels. 
NOTE: You can also type the text first, highlight the section, and press the 
Bulleted List or Numbered List buttons to add the bullets or numbers.  
Nested Lists 
To create a nested list, such as a numbered list inside of a bulleted list, follow 
these steps: 

 Type the list and increase the indentation of the items that will make up the 
nested list by clicking the Increase Indent button for each item. 
 

 Highlight the items and click the Numbered List button on the formatting 
toolbar.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Formatting Lists 
 
 
Using the Bullets and Numbering dialog box can change the bullet image and 
numbering format. 

 Highlight the entire list to change all the bullets or numbers, or 
Place the cursor on one line within the list to change a single bullet.  
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 Access the dialog box by selecting Format| Bullets and Numbering from 
the menu bar or by right-clicking within the list and selecting Bullets and 
Numbering from the shortcut menu. 

 

 Select the list style from one of the seven choices given, or click the 
Picture... button to choose a different icon. Click the Numbered tab to 
choose a numbered list style.  

 

 Click OK when finished.  

Tables are used to display data and there are several ways to build them in Word. 
Begin by placing the cursor where you want the table to appear in the document 
and choose one of the following methods. 

 
Borders and  Shading 

• Access the dialog box by selecting Format|  Borders and  Shading from 
the menu bar ,or 

 Right-click within the text and select from the shortcut menu. 

Select the suitable tab to insert the border style, page border style  or shading style 
to the document. And then select the colour ,width , pattern and other options . 
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Change case 
When the text entered is not in the appropriate case ,it can be changed using this 
facility. First select the text and then go to  Format|  change case 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Insert a Table 

There are two ways to add a table to the document using the Insert feature: 

 Click the Insert Table button on the standard toolbar. Drag the mouse along 
the grid, highlighting the number of rows and columns for the table. 
 

 

 

 

 

 

 

 Or, select Table |Insert |Table from the menu bar. Select the number of 
rows and columns for the table and click OK. 
 

 
 
 



                                            
           National Institute of Education 

86

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Draw the Table 
A table can also be drawn onto the document: 

 Draw the table by selecting Table| Draw Table from the menu bar. The 
cursor is now the image of a pencil and the Tables and Borders toolbar 
has appeared. 

 

 

 

 Draw the cells of the table with the mouse. If you make a mistake, click the 
Eraser button and drag the mouse over the area to be deleted.  

 To draw more cells, click on the Draw Table button .  

Inserting Rows and Columns 
Once the table is drawn, insert additional rows by placing the cursor in the row you 
want to be adjacent to. Select Table| Insert| Rows Above or Rows Below. Or, 
select an entire row and right-click with the mouse. Choose Insert Rows from the 
shortcut menu. 
 
 
Much like inserting a row, add a new column by placing the cursor in a cell 
adjacent to where the new column will be added. Select Table |Insert| Columns 
to the Left or Columns to the Right. Or, select the column, right-click with the 
mouse, and select Insert Columns. 
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Moving and Resizing a Table 
A four-sided moving arrow and open box resizing handle will appear on the corners 
of the table if the mouse is placed over the table. Click and drag the four-ended 
arrow to move the table and release the mouse button when the table is positioned 
where you want it. Click and drag the open box handle to resize the table. Change 
the column widths and row heights by clicking the cell dividers and dragging them 
with the mouse. 

 
 
Tables and Borders Toolbar 
The Tables and Borders toolbar allows you to add border styles, shading, text 
effects, alignment, and more options to your table. Access the toolbar by clicking 
Table| Draw Table or View| Toolbars |Tables and Borders. 

 
 
 
 
 

 
 
You will need to highlight the cells of the table you want to format. Click and drag 
the mouse over the cells, or use the following shortcuts: 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Selection Menu Method Mouse Method 

One cell Table |Select| 
Cell 

Click the bottom, left corner of the cell 
when a black arrow appears  

One row Table |Select| 
Row 

Click outside the table to the left of the 
row 

One column Table |Select 
|Column 

Click outside the table above the column 
when a black arrow appears 

Several rows (none) Click outside the table to the left of the 
row and drag the mouse down 

Several 
columns (none) Click outside the table above the column 

Entire table Table| Select| 
Table Triple-click to the left of the table 
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Table Properties 
Use the Table Properties dialog box to modify the alignment of the table with the 
body text and the text within the table. Access the box by selecting Tables| Table 
Properties. 
 

 

 Size - Check the Preferred width box and enter a value if the table should 
be an exact width.  
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 Alignment - Highlight the illustration that represents the alignment of the 
table in relation to the text of the document.  

 Text wrapping - Highlight "None" if the table should appear on a separate 
line from the text or choose "Around" if the text should wrap around the 
table.  

 Borders and Shading - Select from a number of border styles, colors, and 
widths. Click the Shading tab to change the background color and pattern. 

 Options - Click the Options button on the Table Properties window. To 
change the spacing between the document text and the table borders under 
Default cell margins. Check the Allow spacing between cells  and enter 
a value to add space between the table cells. 
 

AutoCorrect 

Word automatically corrects many commonly misspellt words and punctuation 
marks with the AutoCorrect feature. To view the list of words that are automatically 
corrected, select Tools |Auto Correct. This may be a hidden feature so click the 
double arrows at the bottom of the Tools menu listing if the AutoCorrect choice is 
not listed. 

Many options including the accidental capitalization of the first two letters of a word 
and capitalization of the first word of the sentence can be automatically corrected 
from this page. If there are words you often misspell, enter the wrong and correct 
spellings in the Replace and With fields. 

 

 

 

 

 

 

 

 

 

Spelling and Grammar Check 

Word will automatically check for spelling and grammar errors as you type unless 
you turn this feature off. Spelling errors are noted in the document with a red 
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underline. Grammar errors are indicated by a green underline. To disable this 
feature, select Tools| Options from the menu bar and click the Spelling and 
Grammar tab on the dialog box. Uncheck "Check spelling as you type" and 
"Check grammar as you type", and click OK. 

To use the spelling and grammar checker, follow these steps: 

 

 

 

 

 

 

 

 

 Select Tools| Spelling and Grammar from the menu bar.  
 The Spelling and Grammar dialog box will notify you of the first mistake in 

the document and misspellt words will be highlighted in red. 
 

 If the word is spellt correctly, click the Ignore button or click the Ignore All 
button if the word appears more than once in the document.  

 If the word is spellt incorrectly, choose one of the suggested spellings in the 
Suggestions box and click the Change button or Change All button to 
correct all occurrences of the word in the document. If the correct spelling is 
not suggested, enter the correct spelling in the Not In Dictionary box and 
click the Change button.  

 If the word is spellt correctly and will appear in many documents you type 
(such as your name), click the Add button to add the word to the dictionary 
so it will no longer appear as a misspelled word.  

As long as the Check Grammar box is checked in the Spelling and Grammar 
dialog box, Word will check the grammar of the document in addition to the 
spelling. If you do not want the grammar checked, remove the checkmark from this 
box. Otherwise, follow these steps for correcting grammar: 

 If Word finds a grammar mistake, it will be shown in the box as the spelling 
errors. The mistake is highlighted in green text. 
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 Several suggestions may be given in the Suggestions box. Select the 
correction that best applies and click Change.  

 If no correction is needed (Word is often wrong more than it is right), click 
the Ignore button.  

Synonyms 
Word 2000 has a new feature for finding synonyms. Simply right-click on the word 
and select Synonyms from the shortcut menu. From the list of suggested words, 
highlight the word you would like to use or click Thesaurus... for more options. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Thesaurus 
To use the thesaurus, select Tools |Language |Thesaurus from the menu bar or 
select it from the Synonyms shortcut menu as detailed above. 

 
A list of meanings and synonyms are given on the windows. Double-click on the 
words in the Meanings box or click the Look Up button to view similar words. 
Double-click words in the Replace with Synonym box to view synonyms of those 
words. Highlight the word you would like to add and click the Replace button. 
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Adding Clip Art 

To add a clip art image from the Microsoft library to a document, follow these steps 
:Select Insert| Picture |Clip Art from the menu bar. 

 

 

 

 

 

 

 

  

 To find an image, click in the white box following Search for clips. Delete 
the words "Type one or more words. . ." and enter keywords describing the 
image you want to use. 

 

 - OR - 
Click one of the category icons.  
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 Click once on the image you want to add to the document and the following 
popup menu will appear: 

 
 Insert Clip to add the image to the document. 
 Preview Clip to view the image full-size before adding it to the 

document. Drag the bottom, right corner of the preview window to 
resize the image and click the "x" close button to end the preview. 

 

 

 

 

 

  

 Add Clip to Favorites will add the selected image to your favorites 
directory that can be chosen from the Insert ClipArt dialog box.  

 Find Similar Clips will retrieve images similar to the one you have 
chosen.  

 Continue selecting images to add to the document and click the Close 
button in the top, right corner of the Insert ClipArt window to stop adding 
clip art to the document. 

 
 
 
 
Add An Image from a File 
Follow these steps to add a photo or graphic from an existing file: 

 Select Insert| Picture |From File on the menu bar. 
 Click the down arrow button on the right of the Look in: window to find the 

image on your computer.  
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 Highlight the file name from the list and click the Insert button. 
 

 
 
 
 
 
 
 
 
 
 
 
 
Editing A Graphic  
Activate the image you wish to edit by clicking on it once with the mouse. Nine 
handles will appear around the graphic. Click and drag these handles to resize the 
image. The handles on the corners will resize proportionally while the handles on 
the straight lines will stretch the image. More picture effects can be changed using 
the Picture toolbar. The Picture toolbar should appear when you click on the 
image. Otherwise, select View| Toolbars |Picture from the menu bar to activate it. 
 

 
 
 
 

 Insert Picture will display the image selection window and allow you to 
change the image. 

 Image Control allows to to make the image grayscale, black and white, or a 
watermark. 

 More/Less Contrast modifies the contrast between the colors of the image. 

 More/Less Brightness will darken or brighten the image. 

 Click Crop and drag the handles on the activated image to delete outer 
portions of the image. 

 Line Style will add a variety of borders to the graphic. 

 Text Wrapping will modify the way the document text wraps around the 
graphic. 

 Format Picture displays all the image properties in a separate window. 

 Reset Picture will delete all the modifications made to the image.  
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Auto Shapes 
The AutoShapes toolbar will allow you to draw many different geometrical shapes, 
arrows, flow chart symbols, stars, and banners on the document. Activate the 
AutoShapes toolbar by selecting Insert| Picture |AutoShapes or View| Toolbars 
|AutoShapes from the menu bar, or clicking the AutoShapes button on the 
Drawing toolbar. Click each button on the toolbar to view the options for drawing 
the shape. 
 
 
 
 
 

 Lines - After clicking the Lines button on the AutoShapes toolbar, draw a 
straight line, arrow, or double-ended arrow from the first row of options 
by clicking the respective button. Click in the document where you would 
like the line to begin and click again where it should end. To draw a curved 
line or freeform shape, select curved lines from the menu (first and second 
buttons of second row), click in the document where the line should appear, 
and click the mouse every time a curve should begin. End creating the 
graphic by clicking on the starting end or pressing the ESC key. To 
scribble, click the last button in the second row, click the mouse in the 
document and hold down the left button while you draw the design. Let go of 
the mouse button to stop drawing. Basic Shapes - Click the Basic Shapes 
button on the AutoShapes toolbar to select from many two- and three-
dimensional shapes, icons, braces, and brackets. Use the drag-and-drop 
method to draw the shape in the document. When the shape has been 
made, it can be resized using the open box handles and other adjustments 
specific to each shape can be modified using the yellow diamond handles. 
 

 

 

 

 

 

 Block Arrows - Select Block Arrows to choose from many types of two- 
and three-dimensional arrows. Drag-and-drop the arrow in the document 
and use the open box and yellow diamond handles to adjust the 
arrowheads. Each AutoShape can also be rotated by first clicking the Free 
Rotate button on the drawing toolbar . Click and drag the green handles 
around the image to rotate it.  
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 Flow Chart - Choose from the flow chart menu to add flow chart elements 
to the document and use the line menu to draw connections between the 
elements. 

 Stars and Banners - Click the button to select stars, bursts, banners, and 
scrolls.  

 Call Outs - Select from the speech and thought bubbles, and line call 
outs. Enter the call out text in the text box that is made. 

 More AutoShapes - Click this button to choose from a list of clip art 
categories.  

Each of the submenus on the AutoShapes toolbar can become a separate toolbar. 
Just click and drag the gray bar across the top of the submenus off of the toolbar 
and it will become a separate floating toolbar. 

Page Margins 

The page margins of the document can be changed using the rulers on the page 
and the Page Setup window. The ruler method is discussed first: Move the mouse 
over the area where the white ruler changes to gray. 
 

 When the cursor becomes a double-ended arrow, click with the mouse and 
drag the margin indicator to the desired location.  

 Release the mouse when the margin is set.  

 
 
 
 
 
 
 
 
 
 
 
 
The margins can also be changed using the Page Setup dialog box: 

 Select File| Page Setup and choose the Margins tab in the dialog box. 
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 Enter margin values in the Top, Bottom, Left, and Right boxes. The 
Preview window will reflect the changes.  

 If the document has Headers and/or Footers, the distance this text appears 
from the edge of the page can be changed.  

 Click OK when finished. 

Page Size and Orientation 
Change the orientation page within the Page Setup dialog box. 

 Select File |Page Setup and choose the Paper Size tab. 
 

 Select the proper paper size from the drop-down menu.  
 Change the orientation from Portrait or Landscape by checking the 

corresponding radio button. 

 
 
 
 
 
 
 
 
 
 
 
 
Headers and Footers 
A header is text that is added to the top margin of every page such as a document 
title or page number and a footer is text added to the bottom margin.  Follow these 
steps to add or edit headers and footers in the document: 
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 Select View| Header and Footer from the menu bar. The Header and 
Footer toolbar will appear and the top of the page will be highlighted as 
shown  below. 

 Type the heading in the Header box. You may use many of the standard 
text formatting options such as font face, size, bold, italics, etc.  

 Click the Insert AutoText button to view a list of quick options available.  
 Use the other options on the toolbar to add page numbers, the current date 

and time.  
 To edit the footer, click the Switch Between Header and Footer button on 

the toolbar.  
 When you are finished adding headers and footers, click the Close button 

on the toolbar.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Page Numbers 
Follow these instructions for another way to add page numbers to a document. 

 Select Insert|Page Numbers from the menu bar and the following dialog 
box will appear. 

 
 Select the position of the page numbers by choosing "Top of page" or 

"Bottom of page" from the Position drop-down menu.  
 Select the alignment of the page numbers in the Alignment drop-down 

menu.  
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 If you do not want the page number to show on the first page (if it is a title 
page, for example), uncheck the Show number of first page box.  

 Click OK when finished.  

 
Print Preview and Printing 
Preview your document by clicking the Print Preview button on the standard 
toolbar or by selecting File| Print Preview. When the document is ready to print,  

 

 

 

 

 

 

 

 

 
 
 
Click the Print button from the Print Preview screen or select File| Print.  
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Keyboard shortcuts 

Keyboard shortcuts can save time and the effort of switching from the keyboard to 
the mouse to execute simple commands. Print this list of Word keyboard shortcuts 
and keep it by your computer for a quick reference. 

Note: A plus sign indicates that the keys need to be pressed at the same time. 

Action Keystroke 
 

Document actions 
Open a file CTRL+O 
New file CTRL+N 
Close a file CTRL+W 
Save As F12 

Save CTRL+S or 
SHIFT+F12 

Print Preview CTRL+F2 
Print CTRL+P 
Show/Hide paragraph 
symbols CTRL+* 

Spelling and grammar F7 
Help F1 
Find CTRL+F 
Replace CTRL+H 
Go To CTRL+G 
 

Cursor movement 
Select all - entire 
document CTRL+A 

Select from cursor to 
beginning of line SHIFT+Home

Select from cursor to end 
of line SHIFT+END 

Go to beginning of line HOME 
Go to end of line END 
Go to beginning of 
document CTRL+Home

Go to end of document CTRL+End 
 

Formatting 

Action Keystroke 
 

Text Style 
Font face CTRL+SHIFT+F
Font size CTRL+SHIFT+P
Bold CTRL+B 
Italics CTRL+I 
Underline CTRL+U 
Double underline CTRL+SHIFT+D
Word underline CTRL+SHIFT+W
All caps CTRL+SHIFT+A
Change case SHIFT+F3 
Subscript CTRL+= 
Superscript CTRL+SHIFT+=
Make web hyperlink CTRL+K 
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Cut CTRL+X 
Copy CTRL+C 
Paste CTRL+V 
Undo CTRL+Z 
Redo CTRL+Y 
Format painter CTRL+SHIFT+C 
Left alignment CTRL+L 
Center alignment CTRL+E 
Right alignment CTRL+R 
Justified CTRL+J 
Delete previous 
word CTRL+Backspace

Apply bulleted list CTRL+SHIFT+L 
Indent CTRL+M  
Page break CTRL+Enter  

 
Miscellaneous 

Copyright symbol - © ALT+CTRL+C 
Date field ALT+SHIFT+D 
Go to footnotes ALT+CTRL+F 
Show/Hide ¶ CTRL+SHIFT+8
Thesaurus SHIFT+F7 

Tables 
Go to next 
cell Tab 

Go to 
previous cell SHIFT+Tab 

Go to 
beginning of 
column 

ALT+PageUp 

Highlight to 
beginning of 
column 

ALT+SHIFT+PageUp 

Go to end of 
column ALT+PageDown 

Highlight to 
end of 
column 

ALT+SHIFT+PageDown

Go to 
beginning of 
row 

ALT+Home 

Highlight to 
beginning of 
row 

ALT+SHIFT+Home 

Go to end of 
row ALT+End 

Highlight to 
end of row ALT+SHIFT+End 

Column 
break CTRL+SHIFT+Enter 
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All Shortcuts 

This list shows only the most common keyboard shortcuts. To print a list of all the 
shortcuts in Word, follow these steps: 

 Select Tools| Macro| Macros from the menu bar.  
 From the Macros In drop-down menu, select Word Commands.  
 Select List Commands from the macro listing.  
 Click the Run button.  
 Choose Current Menu and Keyboard Settings from the popup window 

and click OK.  
 Word will automatically open a new document containing a table of 

keystrokes. Print the document. 
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3.3 Electronic Spreadsheets 
 

3.3.1   Introduction to the Electronic Spreadsheets 
 
A spreadsheet is a sheet that contains a large number of rows and columns like a 
table. A Collection of sheets is called a Workbook. It helps to arrange numbers in a 
formal mathematical manner so that it can be used for mathematical, financial, 
statistical & Scientific calculations. It helps to analyze data using Sorting, Filtering, 
Charts and Pivot tables  
 
Various Spreadsheet Packages  

• VisiCalc( VISIble CALculator) 
• VPP 3D 
• SuperCalc  MultiPlan 
• Lotus 1-2-3 Quattro Pro Fox pro 
• Lotus Improv- intelligent speared Sheet 

 
Use of a Spreadsheet Package 
In a Business  
 

1. The marketing Department uses Speared Sheet to keep track of sales 
• They can use the information to calculate commission to the sales 

staff and project materials and product requirements for purchasing  
2. The purchasing department uses it to keep track of purchases from 

individual vendors and prices paid for specific products. 
3. Personnel departments use it to keep track of information about Employees. 
4. The Payroll department uses it to  keep track of salary information, 

allowances and loans. 
5. The Accounts department uses it to calculate the monthly account balance. 
 

In engineering analysis 
 

1. A civil engineering department uses it to  determine the dimensions of 
drainage channels or to calculate the stress on a concrete beam on  a 
bridge. 

2. An Electrical engineer uses it to calculate the voltage or capacities in the 
design of electrical circuits. 

3. A Mechanical engineer use it to calculate heat absorption or pressure on 
water. 

In science  
1. A Scientist uses it to analyze their research data and to take a decision 

regarding research 
 
In Graphics & Presentations 
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Spread Sheets are excellent tools for creating graphs and presentation 
materials because these capabilities are built into them. With most spreadsheet 
programs creating a graph is very simple.  

 
 
Opening Work Book and Creating a New Work Sheet 
 
 Introduction to Microsoft Excel Window 
To open Microsoft Excel  

1. Click Start 

2. Then Click Microsoft Excel under program menu item 

the Screen bellow will be displayed 

Rows 

Columns 

Sheet 
Tabs
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Then, if necessary, click on the in the upper right corner of the task pane to close 
the task pane.  
 
 
The Title Bar 

 

Title bar, which is located at the very top of the screen, displays the name of the 
workbook you are currently using. At the top of your screen, you should see 
"Microsoft Excel - Book1" or a similar name. 
The Menu Bar 

 

The Menu bar is located below the Title bar. The menu begins with the word File, 
Edit, View, Insert, Format, Tools, Data, Window, and Help. You can use a menu to 
give instructions to the software.  
 

Point and click with your mouse to a menu item, then you will see a drop-down 
menu open. Use left and right arrow keys on your keyboard to move left and right 

across the Menu bar. Up and Down arrow keys are used to move up and down the 
drop-down menu.  

 
To choose an option, highlight the item on the drop-down menu and press Enter or 

click item. 

The Name Box and Formula Bar 

 
    
 
Name Box    Formula Bar  
 

Task Pane 
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The cell address is displayed in the Name box on the left side of the Formula bar. 
Cell entries displayed on the Formula bar.  

 

Cell addressing 

The A1 vs. the R1C1 reference style 
The A1 reference style    
Excel uses the A1 reference style, which refers to columns with letters (A through 
IV, for a total of 256 columns) and refers to rows with numbers (1 through 65536). 
These letters and numbers are called row and column headings. To refer to a cell, 
enter the column letter followed by the row number. For example, D50 refers to the 
cell at the intersection of column D and row 50. To refer to a range of cells, enter 
the reference for the cell in the upper-left corner of the range, a colon (:), and then 
the reference to the cell in the lower-right corner of the range. The following are 
examples of references. 
 

To refer to Use 

The cell in column A and row 10 A10 

The range of cells in column A and rows 
10 through 20 

A10:A20 

The range of cells in row 15 and columns 
B through E 

B15:E15 

All cells in row 5 5:5 

All cells in rows 5 through 10 5:10 

All cells in column H H:H 

All cells in columns H through J H:J 

The range of cells in columns A through 
E and rows 10 through 20 

A10:E20 

 
 
 
The R1C1 reference style    
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You can also use a reference style where both the rows and the columns on the 
worksheet are numbered. In the R1C1 style, Excel indicates the location of a cell 
with an "R" followed by a row number and a "C" followed by a column number 
 
 

 
 
3.3.2 Insert Data into a worksheet 
 
Text is any combination of numbers, spaces, and nonnumeric characters  

Eg. 10xy, 127NH, A12-976, 208 4675. 

  

All text is left aligned in a cell.  

A5:C5 

G8:H13 

E5:E10 

B2
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Enter the same data into several cells at once 

1. Select the cells where you want to enter data.  

The cells can be adjacent or nonadjacent 

 

 

 

 

  

2.Type data  

 

 

 

2. Press CTRL+ENTER.  
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To display all the texts on multiple lines in a cell 
1. Select the cell B5 
2. Type “ This large text appears on multiple line in the cell” 
3. Press ALT+ENTER 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Keys for moving and scrolling in a worksheet or workbook 
 

Press To 

Arrow keys Move one cell up, down, left, or right 

CTRL+arrow key Move to the edge of the current data region 

HOME Move to the beginning of the row 

CTRL+HOME Move to the beginning of the worksheet 

CTRL+END Move to the last cell on the worksheet, which is 
the cell at the intersection of the rightmost used 
column and the bottom-most used row (in the 
lower-right corner), or the cell opposite the home 
cell, which is typically A1 

PAGE DOWN Move down one screen 

PAGE UP Move up one screen 
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ALT+PAGE DOWN Move one screen to the right 

ALT+PAGE UP Move one screen to the left 

CTRL+PAGE DOWN Move to the next sheet in the workbook 

CTRL+PAGE UP Move to the previous sheet in the workbook 

CTRL+F6 or CTRL+TAB Move to the next workbook or window 

CTRL+SHIFT+F6 or 
CTRL+SHIFT+TAB 

Move to the previous workbook or window 

F6 Move to the next pane in a workbook that has 
been split 

SHIFT+F6 Move to the previous pane in a workbook that has 
been split 

CTRL+BACKSPACE Scroll to display the active cell 

F5 Display the Go To dialog box 

SHIFT+F5 Display the Find dialog box 

SHIFT+F4 Repeat the last Find action (same as Find Next) 

TAB Move between unlocked cells on a protected 
worksheet 

 
Keys for moving in a worksheet with End mode on 
 

Press To 

END Turn End mode on or off 

END, arrow key Move by one block of data within a row or column 

END, HOME Move to the last cell on the worksheet, which is 
the cell at the intersection of the rightmost used 
column and the bottom-most used row (in the 
lower-right corner), or the cell opposite the home 
cell, which is typically A1 

END, ENTER Move to the last cell to the right in the current row 
that is not blank; unavailable if you have selected 
the Transition navigation keys check box on the 
Transition tab (Tools menu, Options command) 

ENTER Move from top to bottom within the selection 
(down), or move in the direction that is selected on 
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the Edit tab (Tools menu, Options command) 

SHIFT+ENTER  Move from bottom to top within the selection (up), 
or move opposite to the direction that is selected 
on the Edit tab (Tools menu, Options command) 

TAB Move from left to right within the selection, or 
move down one cell if only one column is selected 

SHIFT+TAB Move from right to left within the selection, or 
move up one cell if only one column is selected 

CTRL+PERIOD Move clockwise to the next corner of the selection 

CTRL+ALT+RIGHT ARROW Move to the right between nonadjacent selections 

CTRL+ALT+LEFT ARROW Move to the left between nonadjacent selections 

 
Keys for inserting, deleting, and copying a selection 

Press To 

CTRL+C Copy the selection 

CTRL+X Cut the selection 

CTRL+V Paste the selection 

DELETE Clear the contents of the selection 

CTRL+HYPHEN Delete the selection 

CTRL+Z Undo the last action 

CTRL+SHIFT+PLUS SIGN Insert blank cells 

 
 
Tips on entering numbers 
Numbers    
A number can contain only the following characters: 
0 1 2 3 4 5 6 7 8 9 + - ( ) , / $ % . Ee 
Excel ignores leading plus signs (+) and treats a single period as a decimal. All 
other combinations of numbers and nonnumeric characters are treated as text. 
 
 
Entering negative numbers    
Start with minus sign (-), or enclose the numbers in parentheses ( ). 



                                            
           National Institute of Education 

112

Aligning numbers    
All numbers are right aligned in a cell. To change the alignment, select the cells. 
On the Format menu, click Cells, click the Alignment tab, and then select the 
options you want. 
 
How numbers appear   The number format that is applied to a cell determines the 
way Excel displays a number on a worksheet if you type a number into a cell that 
has the General number format, Excel may apply a different number format. For 
example, if you type $14.73, Excel applies a currency format. To change the 
number format, select the cells that contain the numbers. On the Format menu, 
click Cells, click the Number tab, and then select a category and format. 
 
The General number format   In cells that have the default General number 
format, Excel displays numbers as integers (789), decimal fractions (7.89), or 
scientific notation (7.89E+08). If the number is longer than the width of the cell, the 
General format displays up to 11 digits, including a decimal point and characters 
such as "E" and "+." To use numbers with more than 11 digits, you can apply a 
built-in scientific number format (exponential notation) or a custom number format. 
 
15-digit limit   Regardless of the number of digits displayed, Excel stores numbers 
with up to 15 digits of precision. If a number contains more than 15 significant 
digits, Excel converts the extra digits to zeros (0). 
 
Entering numbers as text   Excel stores a number as numeric data even if you 
use the Cells command to apply the text format to the cells that contain the 
numbers. To have Excel interpret numbers such as part numbers as text, first 
apply the Text format to empty cells, and then type the numbers. If you've already 
entered the numbers, apply the Text format to the cells. 
 
Regional settings    The characters recognized as numbers depend on the 
options you select in the Regional Settings of Control Panel. The options selected 
also determine the default format for numbers — for example, the period (.) used 
as the decimal symbol on United States-based systems. 
 
Tips on entering dates and times 
 
Dates and times are numbers   Microsoft Excel treats dates and times as 
numbers. The way that a time or date is displayed on a worksheet depends on the 
number format applied to the cell. When you type a date or time that Excel 
recognizes, the cell's format changes from the General number format to a built-in 
date or time format. By default, dates and times are right aligned in a cell. If Excel 
cannot recognize the date or time format, the date or time is entered as text, which 
is left aligned in the cell. 
 
Use a 4-digit year   When entering dates such as December 01, Excel matches 
the day first and then the year. For instance, December 01 is entered as December 
1 of the present year, not as December of the year 2001. 
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Entering dates and times together   To type a date and time in the same cell, 
separate the date and time with a space. 
 
The 12-hour or 24-hour clock   To type a time based on the 12-hour clock, type a 
space followed by AM or PM (or A or P) after the time. Otherwise, Excel bases the 
time on the 24-hour clock. For example, if you type 3:00 instead of 3:00 PM, the 
time is stored as 3:00 AM. 
 
The 1904 date system   In Excel for Windows (and Lotus 1-2-3), days are 
numbered from the beginning of the century; the date serial number 1 corresponds 
to the date January 1, 1900. Excel for Macintosh uses the 1904 date system; the 
date serial number 1 corresponds to January 2, 1904. To change the date system 
for use in calculations, click Options on the Tools menu, and then click the  
 
Calculation tab. Under Workbook options, select the 1904 date system check 
box. Use the 1904 date system for a workbook if you use that workbook with other 
workbooks that use the 1904 date system. 
 
If you open in Excel for Windows a file created in Excel version 2.0 or later for the 
Macintosh, Excel recognizes the file format and automatically changes dates to the 
1900 date system. Similarly, if you open an Excel for Windows file on a Macintosh, 
Excel changes dates to the 1904 date system. 
 
 
Edit cell contents 

1. Double-click the cell that contains the data you want to edit. 

2. Make any changes to the cell contents. 

3. Press ENTER.  

Enter fractions    

To avoid entering a fraction as a date, precede fractions with a 0 (zero)  
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Eg.  0 1/2. 
 
Typing numbers like 1/2, 2/3, 5/10 
Step 1  

Click cell A1 
Type 1/2 and press Enter Key – The data is displayed as date 

 
Step 2 

Click B1 
Type 0 1/2  (Zero,  space and 1/2 ) then press Enter Key 

 
 

Clear contents, formats, or comments from cells 

1. Select the cells, rows, or columns you want to clear. 

2. On the Edit menu, point to Clear, and then click All, Contents, Formats, or 
Comments.  

Notes  

• When you  press DELETE or BACKSPACE, then it removes the cell 
contents but does not remove any comments or cell formats. 
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• If you clear a cell, then it removes the contents, formats, comments, or all 
three from a cell. The value of a cleared cell is 0 (zero), and a formula that 
refers to that cell will receive a value of 0.  

Undo mistakes 

• To undo recent actions one at a time, click Undo Button Or press CTRl+Z.  

To undo several actions at once, click the arrow next to Undo and select 
from the list. Microsoft Excel reverses the selected action and all actions 
above it.  

To cancel an entry in a cell or the formula bar before you press ENTER, 
press ESC.  

 Insert cells, rows, or columns 

You can insert blank cells, rows, and columns and fill them with data. If you're 
moving and copying cells, you can insert them between the existing cells to avoid 
pasting over data. 
 
Insert blank cells  

1. Type the Following Data on a sheet 

 

 

 

 

 

 

 

2. Select the range c3:c4 

3. On the Insert menu, click Cells. 
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4. Click Shift cells right.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Insert columns 

1. To insert a single column, click a cell in the column immediately to the right 
of where you want to insert the new column. For example, to insert a new 
column to the left of Column B, click a cell in Column B.  

To insert multiple columns, select columns immediately to the right of where 
you want to insert the new columns. Select the same number of columns, as 
you want to insert.  

2. On the Insert menu, click Columns.  

Insert rows 

1. To insert a single row, click a cell in the row immediately below where you 
want the new row. For example, to insert a new row above Row 5, click a 
cell in Row 5.  

To insert multiple rows, select rows immediately below where you want the 
new rows. Select the number of rows you want to insert.  

2. On the Insert menu, click Rows.  

 
Move or copy whole cells 

1. Select the cells you want to move or copy.  
2. Point to the border of the selection.  
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3. To move the cells, drag the selection to the upper-left cell of the paste area. 
Microsoft Excel replaces any existing data in the paste area.  

4. To copy the cells, hold down CTRL as you drag.  

To insert the cells between existing cells, hold down SHIFT (if moving) or 
SHIFT+CTRL (if copying) as you drag. 

To drag the selection to a different sheet, hold down ALT and drag over a sheet 
tab.  

 
Tip   To move or copy cells to a different workbook or a long distance, select the 
cells and click Cut Button to move the cells or Copy Button to copy the cells. 
Switch to the other sheet or workbook, select the upper-left cell of the paste area, 
and then click Paste Button 
 
 
Find text or numbers 

1. Select the range of cells you want to search.  

To search the entire sheet, click any cell.  

2. On the Edit menu, click Find. 

3. In the Find what box, enter the text or numbers you want to search for. 

4. In the Look in box, click the type of information you want to search for. 

5. Click  Find Next. 
 

3.3.3 Formatting & Printing  
Apply borders to cells 

1. Select the cells you want to add borders to. 

To apply the most recently selected border style, click Borders Button on the 
Formatting toolbar To apply a different border style, click the arrow next to 
Borders Button, and then click a border on the palette.  
Tips  

• More border settings   To apply additional border styles, click Cells on the 
Format menu, and then click the Border tab. Click the line style you want, 
and then click a button to indicate the border placement. 

• Borders and rotated text   To apply borders to selected cells that contain 
rotated text, use the Outline and Inside buttons on the Border tab. The 
borders are applied to the edges of the cells, which are rotated to the same 
degree as the rotated text. 
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• Border styles   To change the line style of an existing border, select the 
cells that the border appears on. On the Border tab, click a new style in the 
Style list, and then click the border you want to change in the diagram 
under Border.  

Shade cells in solid colors 

1. Select the cells you want to apply shading to. 

2. To apply the most recently selected color, click Fill Color on the 
Formatting toolbar 

 

3.  

To apply a different color, click the arrow next to Fill Color, and then click a 
color on the palette.  
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Remove borders 

1. Select the cells you want to remove borders from. 

2. On the Formatting toolbar, click the arrow next to Borders and then click 
on the palette.  

 
Remove shading 

1. Select the cells you want to remove shading from. 

On the Formatting toolbar, click the arrow next to Fill Color, and then click No 
Fill.  
 

Increase or decrease the number of decimal places shown 

 
Select the cells you want to format. 
 
On the Formatting toolbar, do one of the following:  

To display fewer digits after the decimal point, click Decrease Decimal To 
display more digits after the decimal point, Increase Decimal  

1. Select data  
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3. Click twice Increase Decimal Button 
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Format Cell as Currency 

1. Select the cells 

 
2. Click cells in the format menu 

 
 
3. Select Currency Under the number tab 
4. Select Symbol and Click Ok 
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Show numbers as percentages 

1. Select the cells you want to format. 

2. On the Format menu, click Cells, and then click the Number tab.  
3. In the Category list, click Percentage.  

Notes    

• Numbers above 1 are automatically entered as percentages; and numbers 
below 1 are converted to percentages by multiplying by 100. For example, 
entering 10 results in 10%, and entering .1 results in 10%. To have all 
numbers converted by multiplying by 100, on the Tools menu, click 
Options, click the Edit tab, and then clear the Enable automatic percent 
entry check box. 

• To quickly display numbers as percentages of 100, click Percent Style 
on the Formatting toolbar 
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Show or hide the thousands separator in a number 

1. Select the cells you want to format. 

2. On the Format menu, click Cells, and then click the Number tab.  
3. In the Category list, click Number. 

4. Select or clear the Use 1000 separator (,) check  

Enter a formula 

For information about how formulas calculate values, click .  

1. Click the cell in which you want to enter the formula 

Type = (an equal sign).  
If you click Edit Formula or Paste Function Button, Microsoft Excel inserts an 
equal sign for you.  

2. Enter the formula. 

3. Press ENTER.  

Tips  

• You can enter the same formula into a range of cells by selecting the range 
first, typing the formula, and then pressing CTRL+ENTER. 

• You can also enter a formula into a range of cells by copying a formula from 
another cell. For more information about copying a formula, click.  

Eg. 

1. Type data as follows 
2. Click Cell E2 

 
3. Type =B2+C2+D2  
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4.  Press Enter Key 

 
5. Copy formula E3 to E 7 

 
 

A formula is an equation that performs operations on worksheet data. Formulas 
can perform mathematical operations, such as addition and multiplication, or they 
can compare worksheet values or join text. Formulas can refer to other cells on the 
same worksheet, cells on other sheets in the same workbook, or cells on sheets in 
other workbooks.  
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Entering formulas   When you create a formula that contains a function, the 
Formula Palette helps you enter worksheet functions. As you enter a function into 
the formula, the Formula Palette displays the name of the function, each of its 
arguments, a description of the function and each argument, the current result of 
the function, and the current result of the entire formula. To display the Formula 
Palette, click Edit Formula Button in the formula bar 
 
Editing formulas   You can use the Formula Palette to edit functions in formulas. 
Select a cell that contains a formula, and then click Edit Formula Button 

 
 
To display the Formula Palette. The first function in the formula and each of its 
arguments appear in the palette. You can edit the first function or edit another 
function in the same formula by clicking in the formula bar anywhere within the 
function. 
Calculation operators in formulas 
Operators specify the type of calculation that you want to perform on the elements 
of a formula. Microsoft Excel includes four different types of calculation operators: 

arithmetic, comparison, text, and reference. 
 
 
Arithmetic operators    
To perform basic mathematical operations such as addition, subtraction, or 
multiplication; combine numbers; and produce numeric results, use the  

Following arithmetic operators. 
 
 

Arithmetic 
operator 

 
Meaning 

 
Example 

+ (plus sign) Addition 3+3 

– (minus sign) Subtraction 
Negation 

3–1 
–1 

* (asterisk) Multiplication 3*3 

/ (forward slash) Division 3/3 

% (percent sign) Percent 20% 

^ (caret) Exponentiation 3^2 (the same as 3*3)
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Comparison operators    
 
You can compare two values with the following operators. When using these 
operators compares two values, the result is a logical value, either TRUE or 
FALSE. 

Comparison 
operator 

 
Meaning 

 
Example 

= (equal sign) Equal to A1=B1 

> (greater than sign) Greater than A1>B1 

< (less than sign) Less than A1<B1 

>= (greater than or 
equal to sign) 

Greater than or equal to A1>=B1 

<= (less than or equal 
to sign) 

Less than or equal to A1<=B1 

<> (not equal to sign) Not equal to A1<>B1 

 
 
Text concatenation operator    
 
 Ampersand (&) operator used to join, or concatenate, one or more text strings to 
produce a single piece of text. 
 

Text 
operator 

 
Meaning 

 
Example 

& (ampersand) Connects, or concatenates, 
two values to produce one 
continuous text value 

"North" & "wind" produce 
"Northwind" 

 
 
 
  A B C D 

1 First name Last Name Full Name  
2 A.P Saman   
3 K.A Kamal   
4 R.Y Sunil   
5 P. Ranil   
6 S.T Nimal   
7     
8     
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• Click Cell c2 
• Type =A2&" "&B2 
• Press Enter 

 
  A B C D 

1 First name Last Name Full Name  
2 A.P Saman A.P Saman 
3 K.A Kamal   
4 R.Y Sunil   
5 P. Ranil   
6 S.T Nimal   
7     
8     
9     

 
Reference operators   Combine ranges of cells for calculations with the following 
operators. 
 

Reference 
operator 

 
Meaning 

 
Example 

: (colon) Range operator, which 
produces one reference to 
all the cells between two 
references, including the 
two references 

B5:B15 

, (comma) Union operator, which 
combines multiple 
references into one 
reference 

SUM(B5:B15,D5:D15) 

 
Key The order in which Microsoft Excel performs operations in 
formulas 
 
If you combine several operators in a single formula, Microsoft Excel performs the 
operations in the order shown in the following table. If a formula contains operators 
with the same precedence — for example, if a formula contains both a 
multiplication and division operator — Excel evaluates the operators from left to 
right. To change the order of evaluation, enclose the part of the formula to be 
calculated first in parentheses. For more information about calculation operators, 
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Operator Description 

: (colon)  

  (single space) 

, (comma) 

Reference operators 

– Negation (as in –1) 

% Percent 

^ Exponentiation 

* and / Multiplication and division 

+ and –  Addition and subtraction 

& Connects two strings of text 
(concatenation) 

= < > <= >= <> Comparison 

 
Function 

A pre-written formula that takes a value or values, performs an operation, and 
returns a value or values. Use functions to simplify and shorten formulas on a 
worksheet, especially those that perform lengthy or complex calculations. 

Sum Function 

Adds all the numbers in a range of cells. 

Syntax 

SUM (number1,number2, ...) 
 

Number1, number2, ...   are 1 to 30 arguments for which you want the total value 
or sum.  
 
Numbers, logical values, and text representations of numbers that you type directly 
into the list of arguments are counted. See the following first and second 
examples. 
 
 
 
Eg1 
 

SUM(3, 2) equals 5 
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. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ex 2 

 
 
 
 
 
Find maximum value -Max Function 

1. Click B8 Cell 
2. Type =Max(B2:B7) 
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3. Press Enter 
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IF function 
 
Returns one value if a condition you specify evaluates to TRUE and another value 
if it evaluates to FALSE. 
 
Syntax 
IF(logical_test,value_if_true,value_if_false) 
 
Logical_test   is any value or expression that can be evaluated to TRUE or 
FALSE. For example, A10=100 is a logical expression; if the value in cell A10 is 
equal to 100, the expression evaluates to TRUE. Otherwise, the expression 
evaluates to FALSE.  
 
Value_if_true   is the value that is returned if logical_test is TRUE.  
 

Value_if_false   is the value that is returned if logical_test is FALSE.  
 
 
Ex 1 
 

1 Click Cell F2 
2. Type = IF (E2>50,”Pass”,”Fail”) 

 
 

3. Press Enter Key 
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Note  IF Average >70 display "A" 

If Average <70 and >60 display "B" 
If average <60 and >50 display "C" 
Otherwise display "D" 

 
type and See this Function 

=IF(E2>=70,"A",IF(E2>=60,"B",IF(E2>=50,"C","D"))) 
 
Ex 2 
 

  A B C D E F G 
1  Income  Jan Feb Mar Apr 
2   Basic Salary 12000 12000 12000 12000
3   Allowances 2000 2000 2000 2000
4   O/T 1500 1500 1500 1500
5   Tax 1200 1200 1300 1250
6   Net Salary     
7        
8        
9        

10  Expenditure      
11   Food 6000 7066 7000 756
12   Traveling 2000 1500 1400 2500
13   Water Bill 500 450 523 625
14   Electricity Bill 600 700 652 875
15   Telephone 1000 1200 1500 1200
16   Total expenditure     
17  Balance      

Sheet Tab 
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1.  
• Select D2 to G18 
• Click cells in the format menu 
• Select  currency under number tab 
 

 
  A B C D E F G 
1  Income Jan Feb Mar Apr 
2   Basic Salary $12,000.00 $12,000.00 $12,000.00 $12,000.00
3   Allowances $2,000.00 $2,000.00 $2,000.00 $2,000.00
4   O/T $1,500.00 $1,500.00 $1,500.00 $1,500.00
5   Tax $15,500.00 $15,500.00 $15,500.00  $15,500.00 
6        
7        
8        
9        

10  Expenditure     
11   Food $6,000.00 $7,066.00 $7,000.00 $756.00
12   Traveling $2,000.00 $1,500.00 $1,400.00 $2,500.00
13   Water Bill $500.00 $450.00 $523.00 $625.00
14   Electricity Bill $600.00 $700.00 $652.00 $875.00
15   Telephone $1,000.00 $1,200.00 $1,500.00 $1,200.00

16   
Total 
expenditure $10,100.00 $10,916.00 $11,075.00  $5,956.00 

17  Balance $5,400.00 $4,584.00 $4,425.00 $9,544.00
 
2. To Find Net salary 

• Select D6 to G6 
• Type =Sum(D2:D5) 
• Press Ctrl+Enter 

 
3. To Find Total expenditure 

• Select D16:G16 
• Type =Sum(D11:D15) 
• Press Ctrl+Enter 

 
1. To find Balance 

• Select D17 to G17 
• Type =D16-D5 
• Press Ctrl +Enter 
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Managing Work sheet 

 
Move or copy sheets 
  

1. To move or copy sheets to another existing workbook, open the workbook 
that will receive the sheets. 

2. Switch to the workbook that contains the sheets you want to move or copy, 
and then select the sheets.  

3. On the Edit menu, click Move or Copy Sheet. 

4. In the to book box, click the workbook to receive the sheets.  

To move or copy the selected sheets to a new workbook, click New book.  

5. In the before sheet box, click the sheet before which you want to insert the 
moved or copied sheets. 

6. To copy the sheets instead of moveing them, select the Create a copy 
check box.  

Tip   To move sheets within the current workbook, you can drag the selected 
sheets along the row of sheet tabs. To copy the sheets, hold down CTRL, and then 
drag the sheets; release the mouse button before you release the CTRL key. 
 
 
Insert a new worksheet 

• To add a single worksheet,  
• click Worksheet on the Insert menu.  

 
To add multiple worksheets 

• hold down SHIFT, and then click the number of worksheet tabs you 
want to add in the open workbook.  

• Then click Worksheet on the Insert menu.  
 
Delete sheets from a workbook 

• Select the sheets you want to delete.  
• On the Edit menu, click Delete Sheet.  

Rename a sheet 
• Double-click the sheet tab. 
• Type a new name over the current name.  

Display formulas or values on a worksheet 
• To switch between displaying formulas and their values for all 

formulas on a worksheet, press CTRL+` (single left quotation mark).  
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Create a chart 
Create a chart from nonadjacent selections 

1. Select the first group of cells that contain the data you want to include. 

2. While holding down CTRL, select any additional cell groups you want to 
include.  

The nonadjacent selections must form a rectangle.  

3. Click Chart Wizard . 

 
Save a new, unnamed workbook 

2. On the File menu, click Save As. 

In the Save in list, select the drive and folder where you want to save the 
workbook. 
To save the workbook in a new folder, click Create New Folder  

3. In the File name box, type a name for the workbook.  
4. Click Save.  

 
 
Save an existing workbook 

• Click Save 

About workbooks and worksheets 
Workbooks   In Microsoft Excel, a workbook is the file in which you work and store 
your data. Because each workbook can contain many sheets, you can organize 
various kinds of related information in a single file. 
 
Worksheets   Use worksheets to list and analyze data. You can enter and edit data 
on several worksheets simultaneously and perform calculations based on data 
from multiple worksheets. When you create a chart, you can place the chart on the 
worksheet with its related data or on a separate chart sheet 
 
Sheet tabs   The names of the sheets appear on tabs at the bottom of the 
workbook window. To move from sheet to sheet, click the sheet tabs. 
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Freeze panes 

Freezing panes (pane: A portion of the document window bounded by and 
separated from other portions by vertical or horizontal bars.) allows you to select 
data that remains visible when scrolling in a sheet. For example, keeping row and 
column labels visible as you scroll. 

 

1. To freeze a pane, do one of the following:  

The top horizontal pane    Select the row below where you want the split to 
appear. 

The left vertical pane    Select the column to the right of where you want 
the split to appear. 

Both the upper and left panes    Click the cell below and to the right of 
where you want the split to appear. 

2. On the Window menu, click Freeze Panes.  

 
 
Chart  
 
Type This Mark Sheet 
 
      
First name Last Name Full Name Maths English Science 
A.P Saman A.P Saman 56 45 63 
K.A Kamal K.A Kamal 86 98 45 
R.Y Sunil R.Y Sunil 56 57 58 
P. Ranil P. Ranil 36 25 74 
S.T Nimal S.T Nimal 56 36 68 
      
      

 
Select names and Marks For the Students 

 
 

1. C
l
i
c
k 

 
 

First name Last Name Full Name Maths English Science 
A.P Saman A.P Saman 56 45 63 
K.A Kamal K.A Kamal 86 98 45 
R.Y Sunil R.Y Sunil 56 57 58 
P. Ranil P. Ranil 36 25 74 
S.T Nimal S.T Nimal 56 36 68 
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 Chard Wizard Button Or click chart in the insert menu (you will see following 
screen) 
 
 

 
Click Next Button 
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Type  
Grade 10 Term Test 
Students 
marks 

For the Chart Title, Category (X) axis and Value(y) axis respectively 
 

 
 
 
Then click next 
 

 
 
 
Click as new Sheet button and click Finish 
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Print the active sheets, a selected range, or an entire workbook 
 
 
 
If the worksheet has a defined print area, Microsoft Excel will print only the print 
area. If you select a range of cells to print and then click Selection, Microsoft Excel 
prints the selection and ignores any print area defined for the worksheet. 

1. On the File menu, click Print 
2. Under Print what, select the option you want.  

Tip   If you want to print more than one sheet at the same time, select the sheets 
before you print. For more information about selecting multiple sheets, 
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3.4 Database Software 
 
3.4.1 Brief introduction to databases 
 
What is a database?  Quite simply, it’s an organized collection of data related to a 
particular subject or purpose.  A database management system (DBMS) such as 
Access, FileMaker Pro, Oracle or SQL Server provides you with the software tools 
you need to organize that data in a flexible manner.  It includes facilities to add, 
modify or delete data from the database, ask questions (or queries) about the data 
stored in the database and produce reports summarizing selected contents. 
 
Databases are designed to offer an organized mechanism for storing, managing 
and retrieving information. They do so through the use of tables. 
 
Just like Excel tables, database tables consist of columns and rows. Each column 
contains a different type of attribute and each row corresponds to a single record. 
 
Databases are actually much more powerful than spreadsheets in the way you’re 
able to manipulate data. Here are just a few of the actions that you can perform on 
a database that would be difficult if not impossible to perform on a spreadsheet:  

• Retrieve all records that match certain criteria  
• Update records in bulk  
• Cross-reference records in different tables  
• Perform complex aggregate calculations  

Tables comprise the fundamental building blocks of any database. Examine the 
construction of the table and you'll find that each column of the table corresponds 
to a specific employee characteristic (or attribute in database terms).  Each row 
corresponds to one particular employee and contains his or her information 

Tables allow us to create the framework for storing information in a database.  
Obviously, a database that only stores information would be useless -- we need 
methods to retrieve information as well. 

If you simply want to recall the information stored in a table, Microsoft Access 
allows you to open the table and scroll through the records contained within it.  
However, the real power of a database lies in its capabilities to answer more 
complex requests, or queries.  Access queries provide the capability to combine 
data from multiple tables and place specific conditions on the data retrieved.  

We still need mechanisms to place information into the tables in the first place!  
Microsoft Access provides two primary mechanisms to achieve this goal.  The first 
method is to simply bring up the table in a window by double-clicking on it and 
adding information to the bottom of it, just as one would add information to a 
spreadsheet. 
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Access also provides a user-friendly forms interface that allows users to enter 
information in a graphical form and have that information transparently passed to 
the database.   

Reports provide the capability to quickly produce attractively formatted summaries 
of the data contained in one or more tables and/or queries.  
We learned that this sort of information could be retrieved from our database 
through the judicious use of queries.  However, recall that this information was 
presented in a tabular form -- not exactly the most attractive marketing material!  
Reports allow the inclusion of graphics, attractive formatting and pagination. 

 
Starting Microsoft Access 

Access can be executed by clicking the Start menu in the lower left-hand corner of 
the Windows Desktop. A view of a Windows Desktop is given here: 

  

 

 

 

 

 

 

 

 

 

 

To start Access, 

1. Click on the Start button 
2. Select the Programs menu 
3. Move to the MS Office menu  
4. Click on the Microsoft Access menu  
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Once Access is started, an initial screen will be displayed. 

 

                    

 

 

 

 

 

 

 

 

In this screen the user has three options. 

1. Create a new blank database 
2. Create a new database using wizards 
3. Open an existing database 

To create a blank database  

1. Select the Blank Access database option. 
2. Click OK  

Then the following screen will be displayed. 
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To create the database you have to give it a file name. 
 

1. Fill in a file name in the File name box 
2. Click Create button 
 

In this particular database we have given the file name as “Employee”. When 
giving a name to a database you should keep the following things in mind. 
 

• Keep the name of the database relatively short 
• Do not use spaces or other punctuation in the name of the database. 
• The name of the database should reflect the database's contents. 

 
Then you will get the following screen. This is the main database window. 
 
 
 
 
  
  

 

 

 

 

 

 

 

The tabs in the main window for the database include:  

• Tables - Displays any tables in the database.  
• Queries - Displays any queries saved in the database.  
• Forms - Displays any forms saved in the database.  
• Reports - Displays any reports saved in the database.  
• Macros - Displays any macros (short programs) stored in the database.  
• Modules - Displays any modules (Visual Basic for Applications procedures) 

stored in the database.  

These tabs appear along the left hand side of the window by default. 

 



                                            
           National Institute of Education 

144

3.4.2 Creating and designing tables 

Tables are the main units of data storage in Access. They are made up of one or 
more columns (or fields). 

There are a number of ways to create a table in Access. 

1. Using wizards  ( guide the user through creating a table ) 
2. Using the Design View  ( manually define the columns (fields) and their data 

types. ) 

 

Creating a Table Using the Design View 

 

  

  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Highlight Design view in the dialog box you get and click OK button.  

  

1. Select 
this tab

2. Click 
here 
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The window that appears is called the table design view.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Fill in the Field Name, Data Type and Description for each column/field in the 
table. 
 
Field Name 
 
When naming a field there are some rules to follow. 
 

• Names can be up to 64 characters long  
• Any combination of letters, numbers, spaces, and special characters except 

a period (.), an exclamation point (!), an accent grave (`), and brackets ([ ]) 
can be used. 

• Do not use leading spaces or control characters (ASCII values 0 to 31).  
• Avoid including spaces. 
• Avoid using extremely long names because they are difficult to remember 

and refer to. 
 
It is preferable to use descriptive names for field names.  
 
To define a field name 
 

1.  Click in the top row of the Field Name column. 
3. Type in the name of the field 
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Data Type 
 
Describes what kind of data it can hold. The following data types are available, in a 
Microsoft Access database.  
 

Data type Kind of  data 
Text Text or numbers 
Memo Long text or numbers 
Number Numbers only 
Currency Currency values 
Date/Time Date and Time values 
Auto Number Serial number  
Yes/No Yes/No, True/False 

values 
 
After defining the field name, its data type should be defined. 
 

1. Click in the corresponding row of the data type column. 
2. If the data type is text, keep the default or click the down arrow to select the 

data type. 
 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
Description 
 
In the description column type what type of information  there is in the field.  
After filling out the details, it is necessary to define a primary key to the table. 
 

Primary Key 

 
This is a field that can be used to uniquely identify each record in a table. A 
primary key is used to relate a table to other tables. It doesn’t allow Null values. 
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To define a primary key select the row containing the field which can be used as 
an unique identifier and click on the primary key tool on the standard tool bar.  
Or 
Right click on the field and choose primary key on the popup menu. 
 
To select a field click on the row selector (small box left to the field name)  
When the primary key is defined a small key appears next to the field name. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
Now Save the table by clicking on the Save icon on the tool bar or  
 

1. Click File menu 
2. Select Save 

 
Type a descriptive name for the table and click OK. 
 

  
 

 
Row Selector 
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Close the design view by clicking on the close button. 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select the "PersonalInfo" table in the database window. 
Click Open tab  
Enter data in the datasheet view. 
 
 
 
 
 
 
 
 
 
 
 
 Datasheet view  
 
The table must be saved after entering data. 
 

1. Click on the File menu 
2. Select Save 

To add, delete or change data in an existing table:  

1. Click on the Tables tab on the Access database window. 
2. Highlight the name of the table to be modified and click on the Open button.  
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3. Make the necessary changes to the data.  
4. Click File menu and choose Save to save the changes.  
5. Click  File menu and choose Close to close the table 

3.4.3 Working with simple queries 

Queries are used to view, change, and analyze data in tables.  

In the database window  

1. select Queries 
2. Click New 

  

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
In the New Query window that appear  
 

3. Select Design View 
4. Click OK 

 

The Query Design view has two major sections. In the top section, the table(s) 
used for the query are displayed along with the available fields. In the bottom 
section, those fields that have been selected for use in the query are displayed.  

Each field has several options associated with it:  

• Field - The name of the field from the table  
• Table - The table the field comes from  
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• Sort - The order in which to sort on this field (Ascending, Descending or Not 
Sorted)  

• Show - Whether or not to display this field in the query output  
• Criteria - Indicates how to filter the records in the query output.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Click Add button on the Show Table dialog box to add the table into Query 
design view. 

6. Click Close  
 
 
 
 
 
 
 
 
 
 
 
 
 

• The field list is added to the top portion of the design view. 
• Add fields to the Field row of the design grid by dragging relevant fields from 

the field list.  
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• Specify conditions on which data should be selected in Criteria row. 
• To view the results click View button on the tool bar. 

 
3.4.4 Generating forms 
 
Data entry forms are the primary means of entering or displaying data in a 
database. They offer a more user-friendly interface by adding labels for each field 
and other helpful information. 
Access provides several different ways of creating data entry forms. 

1. Using a Design View  
2. Using a wizard  

 
Creation of a Form using Design View 
 

1. Select Forms from the database object tabs in database window. 
2. Click New 
3. Select Design View in the New Form dialog box. 
4. Select the Table or Enter the Name of the table in the combo box below. 
5. Click OK 
6. Add controls to the Detail area of the design grid of the form from the field 

list. 
7. Save the form by Clicking File menu and selecting Save 
8. Enter a name for the Form in Save As dialog box 
9. Click OK 
10. Close the design view by selecting close from the file menu 
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Entering Data to the table using the form 

1. Select the form from the database window 
2. Click Open from the tool bar  
3. Enter data to the fields. Use the Tab key to move from one field to another. 
4. At the end of the record, press TAB or click New Record on the toolbar to go 

to the next record. 
5. Close the form after entering data. 
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Viewing data in a table using a form 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
When opened the form should appear like this. On the lower left corner of the form 
there is a Record navigation bar. There are five buttons on the Record navigation 
bar. 
 

 
   Go to the first record. 
   Go to the previous record. 
   Go to the next record. 
   Go to the last record. 
   Go past the last record to add a new record. 

 
 
These buttons can be used to move to the next or previous record.  
 
3.4.5 Generating reports 
 
Data can be presented effectively using a report. The size and the appearance of 
the report can be changed to suit our requirements. Reports are often printed out 
on paper rather than just viewed on the screen. 
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Creating a report in Design view 
 

1. In the database window select Report object 
2. Click New 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Select Design View in New Report dialog box. 
4. Select the relevant table from the combo box below in the same dialog box. 
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5. Click OK 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Select the Field Names from the Field list and drag and drop into the design 
grid. 

7. Close the field list by clicking close button. 
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8. Save the report by clicking File menu and selecting Save. 
9. Enter a Report Name and Click OK.  
 

 
 
 
 
 
 
 

10. Click View button on the tool bar to view the Report. 
11. Print the report by clicking File menu and selecting Print command.  

 
 
3.5 Communication Software 
 
3.5.1 Internet browsers 
 
Also called Web browsers are the programs used to surf the web, or used to 
access the World Wide Web, such as Mozilla, Safari, or Internet Explorer. Although 
many different browsers are available, Microsoft Internet Explorer and Netscape 
Navigator are the two most popular ones. 
 
When you first launch your web browser, by double-clicking on the icon on your 
desktop, a predefined web page appears. This page is referred to as your home 
page or start page. With Navigator for instance, you may be taken to Netscape's 
portal page or to a page selected by your Internet service provider. If you want 
however, you can easily change your start page. This article shows you how to do 
it.  
 
The Toolbar  

 
 

 

The row of buttons at the top of your browser, known as the toolbar, helps you 
travel through the web of possibilities, keeping track of where you've been. Since 
the toolbars for Navigator and Internet Explorer differ slightly, we'll first describe 
what the buttons in common do:  
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• The Back button returns you the previous page you've visited.  
• Use the Forward button to return to the page you just came from.  
• Home takes you to whichever home page you've chosen. (If you haven't 

selected one, it will return you to the default home page, usually the 
Microsoft or Netscape website.)  

• Reload or Refresh does just that, loads the web page again. Why would 
you want to do this? Sometimes all of the elements of a web page haven't 
loaded the first time, because the file transfer was interrupted. Also when 
you download a web page, the data is cached, meaning it is stored 
temporarily in your computer's memory. The next time you want that page, 
instead of requesting the file from the web server, your web browser 
accesses it from the cache. But if a web page is updated frequently, as may 
be the case with news, sports scores or financial data, you won't get the 
most current information. By reloading the page, this timely data is updated 
from the web server.  

• Print lets you make a hard copy of the current page loaded in your browser.  
• The Stop button stops the browser from loading the current page.  
• Search connects to directories and search tools on the Microsoft or 

Netscape websites.  
• Bookmarks or Favorites lets you record the addresses of websites you 

want to revisit. Once you add a URL to your list, you can return to that web 
page simply by clicking on the link in your list, instead of retyping the entire 
address.  

The Web consists of: 
 

• Your personal computer. 
• Web browser software to access the Web. 
• A connection to an Internet service provider (ISP) 
• Servers to host the data 
• Routers and switches to direct the flow of data 
• Web pages are stored on web servers located around the globe. 
• Entering the (Uniform Resource Locator) URL of a web page in your web 

browser or clicking a link sends a request to the server, which hosts the 
page. 

• The server sends the web page to your computer and your web browser 
displays it on your screen. 

• A web page is an electronic document written in a computer language 
called HTML  

• Web pages can contain text, graphics, video, animation, and sound, as well 
as interactive features, such as data entry forms. 

• Each page has a unique address known as a URL, which identifies its 
location on the server. 

• Web pages contain hyperlinks to other web pages. Hyperlinks are text and 
images that reference the URLs of other web pages. 

• A website is one or more web pages that relate to a common theme, such 
as a person, business, organization, or a subject, such as sports. 
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• The first page is called the home page, which acts like an index, indicating 
the content on the site. 

 
 
 
3.5.2 Search engines 
Programs on the Internet that help users to search for files and information. 
Examples are Infoseek, Yahoo, Lycos, Excite, and many more. Most search 
engines find files that contain a key word or words typed in by the user. Some 
search engines specialize in a subject area or type of file. Others, called meta-
search engines 
 
Search engines are an essential part of the World Wide Web. They automatically 
index all websites they learn about, and maintain a database of keywords. By 
entering keywords for the subject you are searching for, you can find any number 
of websites, which may (or may not) be what you are looking for. Strictly speaking, 
many modern Search Engines are really directories, where sites have actually 
been reviewed by human beings and placed in an appropriate category. 
 
3.5.3 E-mail (Electronic Mail) 
A form of communication where messages can be sent to individuals or groups on 
networked computers and/or computers equipped for Internet access.  
 
Messages, usually text, sent from one person to another via computer. E-mail can 
also be sent to a large number of addresses automatically. Any communications 
service that permits the electronic transmission and storage of messages and 
attached/enclosed files. 
 
Why Use E-mail? 

This is the most frequently used service on the Internet due to the following 
reasons: 

• We can send a message any time, any where and the recipient can read it 
at his or her convenience. 

• Can send the same message to several people at the same time. 
• Can forward information to co-workers without retyping it. 
• We can save time. E-mail is fast, usually taking no more than a few minutes 

to be received. 
• Can e-mail electronic documents and the recipients can then edit and 

return revised versions. 
• Send messages around the world as easily as to co-workers in the next 

office. 
 
E-mail how it Works on the Internet 
Like a postal address, an e-mail address specifies the destination of an 
electronic message. 

• An Internet e-mail address looks like this: user name@domain name  
• The user name is a unique name that identifies the recipient.  



                                            
           National Institute of Education 

159

• The domain name is the address. Many people can share the same 
domain name.  

• E-mail is sent and received through electronic "post offices" known as mail 
servers. 

• To read your e-mail, you must retrieve it from the mail server. 
• Once you enter the address of the recipient, compose your message, and 

click Send, your e-mail software handles the delivery. 
• If the message isn't delivered, because of an incorrect address, for 

example, you typically receive an e-mail message explaining why. 
• If the message is not delivered, you receive a message explaining the 

problem, along with the full text of the original message. You can correct 
the problem an incorrect e-mail address--and resend it. 

 

• To contains the e-mail addresses of the recipients. This is a mandatory 
entry. 

• CC, short for Carbon Copy, contains the e-mail addresses for people other 
than the primary recipients. This is optional. 

• BCC:, short for Blind Carbon Copy, contains the e-mail addresses of other 
recipients who receive copies, but their names and addresses are hidden 
from the other recipients. This is optional. 

• Subject contains the main topic of the message. Keep this brief. 
Recipients see this in their summary of incoming e-mails. 

• Attachment contains the names of files that you may be sending, for 
example, a word-processing document or a spreadsheet 

• Body contains the message itself, which can be of any length. 

3.5.4 Chat 
An online, real-time interactive communication method using text to send and 
receive instant messages. Two or more individuals connected to Internet have 
real-time text-based conversations by typing messages into their computer. 
Groups gather to chat about various subjects. As you type, everything you type is 
displayed to the other members of the chat group. 
 
It is a bit like e-mail in real time. Users have conversations via the keyboard in 
"Chat rooms" with other users. Chat has been criticized for being addictive as well 
as concerns over unsuitable contact between children and adults. To join a chat 
room you usually have to give your e-mail address and this can lead to spam. 
 
3.5.5 Video Conferencing 
Using a computer, video camera, and network such as the Internet, to conduct a 
live conference between two or more people. Video conferencing is an extremely 
useful method of communication because it saves people the time and expense of 
travel and can often accomplish many of the things a physical meeting can. A two-
person videoconference is known as point-to-point, while more than two people 
involved in a session is a multipoint conference. 



                                            
           National Institute of Education 

160

 
Unit 4. 

Information Systems 
 

What is a system? 

 
A system is a collection of interrelated components that work together to perform a 
specific task or achieve a goal. In a system, the different components are 
connected with each other and they are interdependent.  

What is a subsystem? 

Each component is a subsystem of the original system and carries out a part of the 
system task.  
For example, the human body represents a complete natural system. the human 
body contains complex muscle, bone, respiratory, digestive and circulatory 
subsystems, each providing a specific part of the system task. 
 School, Bank, Library, Supermarket, are some other examples of systems. 
 

What is system boundary? 

A system usually interacts with the external world or environment. The system 
boundary separates the system from its environment. A system’s boundary tells us 
what is inside and what is outside the system. 
   Let us consider the school for example and identify the system boundary. 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In the above example , the system boundary clearly illustrates the components 
inside the school and components outside the system. 

Environment 

System 
 

Principal, Teachers, 
Students, School 
Buildings,   Classrooms, 
Playground, Laboratories 

System 
Boundary 

Parents 

Department of 
Education 
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What are the elements of a system? 

Input 
Process 
Output 

To perform a task or accomplish a goal, a system receives inputs (from the 
environment), process and returns outputs (to the environment). 
 
 
 
 
 
 
 
 
If we consider a school as a system, 

Goal          : Education of students 
Input          : Children, Teachers, Funds 
Processing : Teaching and learning 
Output       : Educated students 

 
 

Can we consider organization as a System? 

      If we look in our surroundings, we see many organizations: such as shops, 
medical centers, communication centers, theatres, universities and others. All of 
these organizations have goals, components, inputs, processing and outputs. 
They can be viewed as systems and analyzed to identify system boundaries, 
system types, environment in which they operate. 
 

What is Information System? 

Data are raw facts. Information is processed data. Information is used to take 
decisions. We use a process to turn data into information. A process is a set of 
logically related tasks performed to achieve a specific outcome. Sometimes, data 
are processed mentally or manually.   
 
 
 

 

 

 

       Input Processing Output 

System 

Data Processing Information 
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What is Manual Information system? 

In a manual Information system, all data processing is done manually. Filing 
cabinets, manual procedures and papers are vital components of a manual 
information system. 
Example 

• Book- keeping system 
• School registration and attendance   keeping system 
• Library books index system 

 

What is Computer-based Information system?  

     A computer-based information system is a single set of hardware, software, 
databases, telecommunications, people and procedures that are configured to 
collect, process ,manipulate, store, and communicate data into information. 
 
 Example 

• Telephone billing system 
• Results produced by the department of examinations 

 
 
 

What are the types of processing Systems 

 Batch processing 
 On line Real time Processing 
 

What is Batch processing? 

Data is collected for a period of times and processed batch wise. The term 
originated in the days when users entered programs on punch cards. These cards 
are fed into the computer batch wise. 
 

What is On line Real time processing? 

A type of computer processing in which the computer responds immediately to 
user requests. Each request is considered to be a transaction. Automatic teller 
machines in banks are an example of transaction processing.  
 
The opposite of transaction processing is batch processing, in which a batch of 
requests is stored and then executed all at one time. Transaction processing 
requires interaction with a user, whereas batch processing can take place without 
a user being present. 
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What are the types of Information Systems? 

 Office Automation System 
 Transaction processing system 
 Management information System 
 Processing control System 
 
  

What is Office automation System? 

Office Automation systems (OAS) are systems that try to improve the productivity 
of employees who need to process data and Information. 
 
   Example : 
           Microsoft Office Package 
 

What is Transaction processing system? 

Transaction processing systems are information system applications that capture 
and process data about (or for) business transactions. They are some time called 
Data Processing Systems (DPS).  A TPS is focused at the orational level of a 
 business. 
 
The management information produced by transaction processing systems usually 
consists of detailed reports of daily transactions or future transactions. The reports 
generated by a TPS are useful only to lower level managers. 
 
A TPS usually operates only within one functional area of a business. For example, 
in an organization each department, marketing, accounting and finance, 
production, and research and development  has its own TPS. 
 
The main components of Transaction processing System are hardware 
(machines), software (instructions or programs), people (programmers, managers, 
or users), procedures (rules), data and information. 
 
 
What are the differences between a manual System and automated 
TPS 
 
Automated system is more Efficient, accurate and more reliable.Automated TPS 
use different component with compared to components of manual system 
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What is Management Information System 

A management Information System (MIS) is mainly concerned with internal 
sources of information. MIS usually takes data from the transaction processing 
systems and summarizes it into a series of management reports. 
 
MIS reports tend to be used by middle management and operational supervisors. 
 

What is Processing control system 

Process control systems are used to control machine and equipment.  e.g.: cement 
production factory, vehicle manufacturing and assembling ,  robots etc. 
 

What is Intelligent information system 

 A computer application that does the work of human experts. For example, there 
are expert systems that can diagnose human illnesses, make financial forecasts, 
and schedule routes for delivery vehicles. Some expert systems are designed to 
take the place of human experts, while others are designed to aid them.  
 
Expert systems are part of a general category of computer applications known as 
artificial intelligence . To design an expert system, one needs a knowledge 
engineer, an individual who studies how human experts make decisions and 
translates the rules into terms that a computer can understand. 
 
 
What is system development life Cycle? 
 
System Development Life Cycle (SDLC) is the overall process of developing 
information systems. It has several steps.. 
  
What are the Steps in System Development Life Cycle?  

• System Analysis 
• System Design 
• Software Development 
• Testing 
• Implementation 
• Maintenance 

 
System Analysis 
In this phase, the systems analysts study the existing system in detail, and identify 
new requirements. 
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System design 
In this step Draw a logical diagram for the new system according to the data 
collected in previous phase 
 
Software Development 
The design specifications are converted into source code of a programming 
language. 
 
Testing 
Before actually implementing the new system into operation,a developed system is 
to be tested in order to remove all errors 
 
Implementation 
The New system to be implemented at this stage has mainly two steps. 
User training and System conversion 
  


